u-create studio

System manual

Translation of the original instructions
## Record of Revision

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change in chapter</th>
<th>Description</th>
<th>Changed by</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>06-2019</td>
<td>-</td>
<td>Newly created</td>
<td>hli, hasl</td>
</tr>
<tr>
<td>01</td>
<td>08-2019</td>
<td>Access to flash storage medium</td>
<td>Updated</td>
<td>hasl</td>
</tr>
</tbody>
</table>
Table of contents

1 Introduction ................................................................................................................ 9
  1.1 Purpose of the document .................................................................................. 9
  1.2 Requirements ....................................................................................................... 9
  1.3 Intended use ......................................................................................................... 10
  1.4 Notes on this document ...................................................................................... 11
    1.4.1 Contents of the document ...................................................................... 11
    1.4.2 Not contained in this document ................................................................. 11
  1.5 Further documentation ....................................................................................... 11
  1.6 Relevant countries and registrations ................................................................. 11

2 Safety instructions ..................................................................................................... 12
  2.1 Representation ..................................................................................................... 12
  2.2 General safety information ................................................................................. 13
  2.3 Personnel safety .................................................................................................. 13
  2.4 Safety instructions for projecting ....................................................................... 13

3 System overview ....................................................................................................... 14
  3.1 Hardware architecture ....................................................................................... 15
  3.2 Software structure .............................................................................................. 15
  3.3 Network design .................................................................................................. 17
  3.4 u-control - CPU modules ................................................................................... 18
  3.5 Buses ..................................................................................................................... 19
    3.5.1 EtherCAT ................................................................................................. 19
    3.5.2 CAN ........................................................................................................... 19
    3.5.3 Modbus TCP/IP ..................................................................................... 19
  3.6 u-create studio Toolsuite .................................................................................... 20
    3.6.1 u-create studio ........................................................................................... 20
    3.6.2 u-create studio C++ ............................................................................... 21
    3.6.3 u-create studio Scope .............................................................................. 22
  3.7 Libraries and interfaces ...................................................................................... 23
    3.7.1 IEC standard libraries .......................................................................... 23
    3.7.2 u-create studio libraries ......................................................................... 23
    3.7.3 OPC UA interface .................................................................................. 24
    3.7.4 REST-API (Representational state transfer) ........................................ 24

4 Operating behavior ................................................................................................... 26
  4.1 Start-up ............................................................................................................... 26
# Table of contents

5 **Software installation** ........................................................................................................... 27  
5.1 Install firmware of the control ......................................................................................... 27  

6 **Configuration** .................................................................................................................. 28  
6.1 Data exchange between control and visualization ............................................................ 28  

7 **Program development** ....................................................................................................... 29  
7.1 Task priorities .................................................................................................................... 29  
7.2 Fast control ....................................................................................................................... 30  
7.3 Device Service ................................................................................................................... 31  
7.3.1 Defined state model ....................................................................................................... 31  
7.3.2 Device Service Item ....................................................................................................... 32  
7.3.3 Defined operation behaviour ......................................................................................... 36  
7.3.4 Status report .................................................................................................................. 37  
7.3.5 Co-routine model .......................................................................................................... 37  

8 **Licensing** .......................................................................................................................... 38  
8.1 Trial license ....................................................................................................................... 38  
8.1.1 Activation of a trial license (single user license) .......................................................... 38  
8.1.2 Activation of a trial license (runtime license) ............................................................. 39  
8.2 Activating a single-user license (software on the PC) ...................................................... 39  
8.3 Activating a runtime license (software on the device) .................................................... 40  
8.4 License status and license overview ............................................................................... 41  
8.5 Device replacement .......................................................................................................... 41  
8.5.1 PC replacement (single-user license) .......................................................................... 41  
8.5.2 Device replacement (runtime license) ........................................................................ 43  
8.6 Reset the license information ......................................................................................... 43  

9 **Device Administration (DevAdmin)** ................................................................................ 45  
9.1 Tab "Diag." ....................................................................................................................... 45  
9.2 Tab "Config." .................................................................................................................... 47  
9.3 Tab "Backup/Restore" ....................................................................................................... 49  
9.4 Tab "Plugins" ..................................................................................................................... 50  
9.4.1 Add plugin to DevAdmin ............................................................................................ 50  
9.5 Change password for DevAdmin ..................................................................................... 51  

10 **Software units** ................................................................................................................. 53  
10.1 Creating a software unit .................................................................................................. 53  
10.2 Example meta.xml ........................................................................................................... 54  

11 **OPC UA Server** .............................................................................................................. 56  
11.1 Overview of variants ....................................................................................................... 56  
11.2 Establishing a connection .............................................................................................. 57
# Table of contents

11.3 Server configuration ................................................................. 59
11.4 Generic variable tree ............................................................... 62
11.5 Creating an information model .................................................. 62
11.6 Logging of server operation ....................................................... 70

12 Node-RED .................................................................................. 72

13 LongtermDiagnosticMonitor .......................................................... 73
   13.1 Monitor ............................................................................... 73

14 Data recorder ............................................................................. 76
   14.1 Configuration ....................................................................... 76
   14.2 Data recording ....................................................................... 78
   14.3 Reading out the buffer .......................................................... 82
   14.4 Recording callback from the application ................................... 83
   14.5 Data locality and real-time ..................................................... 84
   14.6 Size limitations ..................................................................... 84
   14.7 Appendix: C interface ........................................................... 85
      14.7.1 Profile with manual recording ......................................... 88
      14.7.2 Profile with automatic recording ...................................... 89
      14.7.3 Profile with triggered recording ....................................... 90
      14.7.4 Profile with persistence .................................................. 92
      14.7.5 Evaluation of recordings ................................................. 95

15 Diagnostics .................................................................................. 97
   15.1 Control diagnosis ................................................................... 97
      15.1.1 Error codes ................................................................... 97
   15.2 Diagnosis data for Weidmüller ................................................. 98
      15.2.1 Status report .................................................................. 98
      15.2.2 Access to flash storage medium ....................................... 98
   15.3 USB via Ethernet adapter ....................................................... 101

16 Maintenance ............................................................................... 103
   16.1 Executing a firmware update of the system components .......... 103
      16.1.1 Firmware-Update for devices ......................................... 104
      16.1.2 Automatic update during boot-up .................................... 105

17 Technical data ............................................................................ 106

18 Directives and standards .............................................................. 107

19 Appendix: Tutorial - creating an IEC project ................................ 108
   19.1 Creating a new project .......................................................... 108
## Table of contents

19.2  Creating a simple program................................................................. 111  
19.3  Saving u-create studio project ......................................................... 114  
19.4  Load firmware onto device................................................................. 114  
19.5  Configuration of the control............................................................... 117  
19.6  Compiling project and uploading onto control................................. 117  
19.7  Starting the project............................................................................. 118  

20  Appendix: Addressing in the Ethernet (basics)....................................... 120  

21  Appendix: Tutorial FoE........................................................................... 122  

22  Appendix: Tutorial - call C function from IEC....................................... 124  
    22.1  Preconditions and needed components........................................... 124  
    22.2  Task ................................................................................................. 124  
    22.3  Creating the C function and download......................................... 125  
    22.4  Calling the IEC function in the IEC application and download........ 126  

Index........................................................................................................... 128
1 Introduction

1.1 Purpose of the document

This document describes the structure of u-control. In addition, it describes the assembly and installation, the wiring as well as the operation and displays of the modules.

The installation and configuration is described enough to obtain an operationally ready system. "Ready for operation" means that the system and/or the respective CPU modules are ready for loading the customer application.

**Information**

This manual is not addressed to end customers! Necessary safety notes for the end customer have to be taken into the customer manual in the respective national language by the mechanical engineers and system providers.

1.2 Requirements

The system manual is written for everyone using a u-create studio system in combination with a UC20-SL2000-EC or UC20-SL2000-EC-CAN or who plan to use such a system.

Only electricians trained pursuant to VDE 1000-10 are allowed to install and service a system with the help of this system manual.

<table>
<thead>
<tr>
<th>Target group</th>
<th>Requisite knowledge and abilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety engineer for &quot;Functional Safety&quot;</td>
<td>Basic technical training (technical college, engineer training or corresponding professional experience). Knowledge of:</td>
</tr>
<tr>
<td></td>
<td>● Principles of functional safety</td>
</tr>
<tr>
<td></td>
<td>● All current standards and safety regulations for the machine/plant, in particular also knowledge of validation conforming to EN ISO 13849-2.</td>
</tr>
<tr>
<td></td>
<td>● Special risk potential of the machine/system and the production process</td>
</tr>
<tr>
<td></td>
<td>● Specific protective measures to avert machine-specific hazards (based on hazard and risk analysis)</td>
</tr>
<tr>
<td></td>
<td>● In-depth knowledge of national accident prevention regulations.</td>
</tr>
<tr>
<td>Project engineer</td>
<td>Technical basic education (advanced technical education, engineering degree or corresponding professional experience). Knowledge of:</td>
</tr>
<tr>
<td></td>
<td>● The method of operation of a PLC,</td>
</tr>
<tr>
<td></td>
<td>● Current valid safety information,</td>
</tr>
<tr>
<td></td>
<td>● The application.</td>
</tr>
</tbody>
</table>
Target group | Requisite knowledge and abilities
---|---
**Electrician** | Technical training in electrical engineering (based on industry-standard training guidelines).
Knowledge of:
- Current valid safety information,
- Wiring guidelines
- Circuit diagrams
- System analysis and troubleshooting
- Professional manufacture of electrical connections in conformity with national and international regulations.

**Programmer** | Technical training (University of Applied Science, engineering degree or corresponding professional experience).
Knowledge of:
- The method of operation of a PLC,
- Current valid safety information,
- Programming a PLC (IEC61131).

**Start-up operator** | Technical basic education (advanced technical education, engineering degree or corresponding professional experience),
Knowledge of:
- Current valid safety information,
- Method of operation of the machine or system
- Fundamental functions of the application
- System analysis and troubleshooting
- Setting options on the operating devices

**Service technician** | Technical basic education (advanced technical education, engineering degree or corresponding professional experience),
Knowledge of:
- The method of operation of a PLC,
- Current valid safety information,
- Method of operation of the machine or system
- Diagnostic options
- Systematic error analysis and troubleshooting

**1.3 Intended use**

u-control may only be used for the types of use described in the technical descriptions and only in conjunction with recommended/approved third-party equipment/installations.

All modules of u-control have been developed, manufactured, tested and documented in accordance with the appropriate safety standards. Therefore, the products do not pose any danger to the health of persons or a risk of damage to other property or equipment under normal circumstances, provided that the instructions and safety precautions relating to the intended use are properly observed.

The system is intended for installation in a control cabinet and may only be used in the following way:
Introduction

- Only in the industrial sector
- in accordance with regulations
- In a faultless technical condition
- In its original state without unauthorized modifications.

Only alterations and modifications described in the accompanying documentation are authorized.

1.4 Notes on this document

<table>
<thead>
<tr>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>If necessary, also adhere to the documentation accompanying the modules.</em></td>
</tr>
</tbody>
</table>

1.4.1 Contents of the document

- System overview
- Explanation of all interfaces and displays of the devices
- General instructions for installation
- Operating behavior
- Description of the software installation
- Description of software interfaces and services
- Diagnosis and maintenance
- Tutorials

1.4.2 Not contained in this document

- Programming instruction
- Application diagnosis
- Firmware description

1.5 Further documentation

When using u-remote I/O modules, please also refer to the Remote I/O System u-remote manual. The documentation of the tools and libraries is integrated as online help.

1.6 Relevant countries and registrations

Standards and test values which the product conforms to and meets are contained in the chapters "Technical Data" and "EC directives and standards". For the EU guidelines relevant for product conformity please see the declaration of conformity.
2 Safety instructions

2.1 Representation

At various points in this manual, you will see notes and precautionary warnings regarding possible hazards. The symbols used have the following meaning:

**DANGER!**
indicates an imminently hazardous situation, which will result in death or serious bodily injury if the corresponding precautions are not taken.

**WARNING!**
indicates a potentially hazardous situation, which can result in death or serious bodily injury if the corresponding precautions are not taken.

**CAUTION!**
means that if the corresponding safety measures are not taken, a potentially hazardous situation can occur that may result in slight bodily injury.

**Caution**
means that damage to property can occur if the corresponding safety measures are not taken.

**ESD**
This symbol reminds you of the possible consequences of touching electrostatically sensitive components.

**Safety information**
Describes important safety-related requirements or informs about essential safety-related correlations.

**Information**
Identifies practical tips and useful information. No information that warns about potentially dangerous or harmful functions is contained.
2.2 General safety information

The documentation contains the information required to plan the use of u-create studio with UC20-SL2000-EC or UC20-SL2000-EC-CAN.

Familiarity with and correct application of the information contained in these manuals is a prerequisite for successful planning and safe installation, commissioning and maintenance of automation systems. Only qualified persons have the required technical expertise for correct interpretation and implementation of the instructions in these documents.

For reasons of clarity, not every single detail of every version of the products described is listed nor can every practical situation be taken into consideration. If you need further information, please request this from Weidmüller.

When installing, commissioning and servicing u-create products, the instructions given in the relevant part of the documentation must be observed.

2.3 Personnel safety

WARNING!

Unqualified interventions in the control may cause abnormal behavior of the machine/plant or personal injury or damage to the equipment. Only specially qualified staff may carry out activities on the control system.

2.4 Safety instructions for projecting

CAUTION!

- The instructions contained in the further delivered must be precisely followed in all circumstances. Failure to do so could result in the creation of potential sources of danger or the disabling of protective circuits integrated in the u-create system.
- Apart from the safety instructions given in these manuals, safety precautions and accident prevention measures appropriate to the situation in question must also be observed.
- Measures must be taken to ensure that in the event of power dips or power failures, an interrupted program can be properly restarted. In such situations, dangerous operating conditions must not be allowed to occur even temporarily.
- In all situations where faults occurring on the automation system could cause personal injury or significant damage to machinery and equipment, additional external safety measures must be taken in order to ensure the system as a whole remains in a safe operating condition even in the event of a fault.
3 System overview

The field of application of u-control is general machine and plant automation. The system features a modular design and can be set up according to the respective functional requirements.

It comprises the following components:

- Construction kit with I/O modules (u-remote) for various applications that can be added on.
- Toolsuite for automation tasks, consisting of tools for configuration, programming, visualization as well as for commissioning and diagnostics. Software libraries and interfaces are made available to provide support in the programming processes.

---

**Fig. 3-1: Example system structure**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control</td>
</tr>
<tr>
<td>2</td>
<td>UR20 modules</td>
</tr>
<tr>
<td>3</td>
<td>SD card</td>
</tr>
<tr>
<td>4</td>
<td>PWM module</td>
</tr>
<tr>
<td>5</td>
<td>DC motor</td>
</tr>
<tr>
<td>6</td>
<td>UR67 module</td>
</tr>
<tr>
<td>7</td>
<td>UR20 station</td>
</tr>
<tr>
<td>8</td>
<td>Touch panel</td>
</tr>
<tr>
<td>9</td>
<td>Tool-Suite</td>
</tr>
<tr>
<td>10</td>
<td>Ethernet</td>
</tr>
<tr>
<td>11</td>
<td>Field bus</td>
</tr>
</tbody>
</table>
3.1 Hardware architecture

Devices are connected according to their signal type, e.g. via analog or digital input or output modules, interface modules, etc.

CPU modules and I/O modules must be integrated into a control cabinet. Their enclosure only provides mechanical protection; the EMC shielding happens inside the device. For greater distances between the transducers a decentralized groups of I/O module clusters can be used. These can be connected with the CPU module via bus link modules.

The operating and display devices can be arranged at a suitable location somewhere on the machine/plant.

During the start of the system, the runtime system compares the current hardware configuration (actual configuration) with the hardware configuration (set configuration saved in the u-create studio project. Deviations in configuration or faulty modules can be identified via the inquiry of the module status in the IEC application. The response is set here via the program (e.g. error output on the visualization, restricted function in the optional I/O modules, etc.)

3.2 Software structure

The following graphic shows the structure of the software on the u-create system.
The control application runs on the control. There are also libraries and interfaces available via which the control can be accessed via the program.

The tool suite is installed on a PC. The programs are used for parameterization, programming, and diagnostics.

The control software is based on a Debian (Linux) operating system with customized scope.

In addition to the UNIX-based system, the KeBian system consists of a multitude of packages and is therefore individually configurable. In addition to a multitude of publicly available standard packages you can also create your own packages and integrate those in your system. A detailed description of the available standard packages can be found in the Debian documentation under http://www.debian.org/doc/. Under http://www.debian.org/distrib/packages you can find an official listing of packages and their package sources.

The following runtime licences support creating own packages:

- U-CREATE-STUDIO-RT-OLAC
- U-CREATE-STUDIO-RT-OLC

**Information**

*The version designation of your u-create system can be found in the release notes supplied with the version!*

The runtime system used on the control conforms to the IEC Standard in compliance with 61131-3. The following topics are covered:

- IEC programming: All languages
3.3 Network design

The IP address of the network is typically specified by a network administrator. At initial startup of the control with u-create studio the IP addresses of the devices are not attuned with each other. The network settings of the PC or the controls therefore must be adjusted.

The communication connection between PC and control can either take place through a direct connection via an Ethernet cable between the Ethernet interface of the PC and the On-board-Ethernet of the control or via a switch.

If a DHCP server exists on the network, the network address can be obtained automatically. If no DHCP server exists, or if there is a direct connection between the control and the PC, a static network address must be used.

**Information**

*The control and tools do not support NAT (Network Address Translation). This limitation must be taken into consideration, especially when operating via a VPN tunnel or through a firewall!*  
*If a firewall is used in the system, port 1740 must be open for UDP traffic (incoming as well as outgoing). Otherwise a connection to the control will be impossible.*  
*Please contact your network administrator for questions concerning the network operation.*

The PC in the network can only communicate with the control. Communication with additional components of the system is not possible in this network structure.

The IP addresses can be defined when creating a target system ("Create Target"). The following values are preset by default.

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control (X1):</td>
<td>192.168.101.100</td>
</tr>
<tr>
<td>Subnet mask:</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Gateway:</td>
<td>192.168.101.x</td>
</tr>
<tr>
<td>u-view Panel:</td>
<td>192.168.101.x</td>
</tr>
<tr>
<td>USB interface:</td>
<td>192.168.227.1</td>
</tr>
</tbody>
</table>

**Information**

*If more panels are used different IP addresses must be set for them.*
**Information**

To change the IP address of a panel the device must be connected to a network.

The IP addresses of the I/O modules are set in u-create studio EoE settings (see online help).

**Information**

A maximum of 3 handheld terminals can be used simultaneously.

**Connection service PC - system components**

For a service PC to be able to communicate with additional components, it must also be located in the machine network. For that, the service PC is either connected via a switch or directly to the X1 port of the control and must get an IP address by the user that is compatible with the network.

Fig. 3-3: Service PC in the machine network

### 3.4 u-control - CPU modules

<table>
<thead>
<tr>
<th>Designation</th>
<th>Performance data</th>
<th>Interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>UC20-SL2000-EC</td>
<td>Dual Core A9, 512 MB RAM, 8 GB EMMC</td>
<td>• u-remote bus</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EtherCAT Master</td>
</tr>
<tr>
<td>UC20-SL2000-EC-CAN</td>
<td>Dual Core A9, 512 MB RAM, 8 GB EMMC</td>
<td>• u-remote bus</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EtherCAT Master</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CANopen interface</td>
</tr>
</tbody>
</table>

For further information, please refer to the u-control manual or the product catalog (Automation section).
3.5 **Buses**

The sections below list the buses supported by the u-create system and describe them in more detail.

The following master fieldbus interfaces are available depending on the control version:
- EtherCAT
- CAN
- Modbus TCP/IP

The following slave fieldbus interfaces are available depending on the control version:
- Modbus TCP/IP

### 3.5.1 EtherCAT

EtherCAT interfaces can be used for the connection of slave devices (e.g. drives, I/O modules).

**Information**

_the interface X2 can only be used as EtherCAT interface. A use as Ethernet is not possible._

### 3.5.2 CAN

When using the CAN interface, make sure to use UC20-SL2000-EC-CAN with CAN controller.

### 3.5.3 Modbus TCP/IP

Modbus is an open communication protocol for data exchange between a master, which requests or writes data, and slaves, which provide or receive data.

The Modbus protocol is specified for serial connections (Modbus RTU) and for Ethernet (Modbus TCP). Typical applications are transmission of values for non time-critical tasks. The data is provided in single register (16 bit values) or coils (discrete 1 bit values) via a Modbus table defined by the slave manufacturer.

**Configuration**

To communicate with a Modbus server on the control, configuration entries must be set via u-create studio. For detailed information see u-create studio online help.
3.6 u-create studio Toolsuite

The tools are all connected to the control via Ethernet. They are used for configuration, parameterization, programming, debugging and diagnostics on the control. The following tools are made available in the process:

- **Configuration and programming with u-create studio:**
  The programming environment u-create studio is used to configure, parameterize, program and debug control applications.

- **Creating C/C++ programs with u-create studio C++:**
  u-create studio C++ for creating and diagnosis/debugging of a control application in the programming languages C and C++.

- **Diagnostics using u-create studio Scope:**
  u-create studio Scope is used to monitor, record and visualize the values of any variables. Unlike the debugger it will not require the program sequence to be interrupted.

- **u-create studio UosDiagnostic: for expert diagnosis:**
  UosDiagnostic is a tool for diagnosis and is used to display expert information.

The following chapters describe the tools in more detail.

3.6.1 u-create studio

u-create studio development environment offers a comfortable user interface with the following functions:

- Configuration and parameterization of the u-create system (including the PLC configuration)
- Programming according to EN 61131-3
- Integrated module libraries (see library descriptions)
- Library administrator for integrating additional libraries
- Debugging functions (testing program sequence, monitoring and modifying variables, error search).

### Programming languages

u-create studio offers all 5 programming languages standardized in EN 61131-3. Each of these languages has specific characteristics that are ideally suited for carrying out specific tasks. Furthermore u-create studio offers the extension "Function block diagram (FBD)".
### System overview

<table>
<thead>
<tr>
<th>Programming language</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structured text</td>
<td>Textual programming language</td>
<td>&quot;Structured text&quot; comes closest to the programming languages Pascal and C used for the PC. It consists of a series of instructions that can be executed in high-level language (&quot;IF..THEN..ELSE&quot;) or in loops (WHILE..DO).</td>
</tr>
<tr>
<td>Function block diagram</td>
<td>Graphic programming languages</td>
<td>Allow programming with logical symbols. It is very suitable for logic controls.</td>
</tr>
<tr>
<td>Continuous graphic Function Chart</td>
<td></td>
<td>In addition, based on the function chart there is the continuous graphic function chart (CFC) in which elements can be placed freely and feedback can be inserted directly.</td>
</tr>
<tr>
<td>Ladder Diagram</td>
<td></td>
<td>The ladder diagram was developed from the circuit diagram. The representation of a ladder diagram program resembles a circuit diagram - relative to the representation of the logical links.</td>
</tr>
<tr>
<td>Sequential Function Chart</td>
<td></td>
<td>The &quot;Sequential Function Chart&quot; is a chain of control steps that are connected by step-on conditions (transitions).</td>
</tr>
</tbody>
</table>

### Library manager

To facilitate programming u-create studio makes it possible to organize objects that are not related to projects into libraries, such as modules, declarations and visualizations. For this purpose a library administrator is available for integrating and viewing of libraries.

#### 3.6.2 u-create studio C++

u-create studio C++ allows to develop and integrate C or C++ programs in the Weidmüller automation system.

u-create studio C++ also offers the possibility to debug the created C or C++ programs already being processed on the control. Therefore a debug server is running on the control, the user interface for debugging is located in u-create studio C++.

Additionally the u-create system provides the following opportunities for C programming:

- **Cyclic C functions**
Allows the integration of C functions. Thereby it is possible to integrate a function each at start-up, shut-down or when starting or stopping the system. For cyclical processing one or more tasks can be configured (with priorities, watchdogs, ...). For the access to the services of the control and the I/O system libraries which are already embedded into the u-create studio C++ are available.

In u-create studio C++ the project type "Extended C Runtime Project" serves as example. In this example a cyclical callback function and the event callback functions for state transitions of the control and its configuration are displayed.

- **Fast Control in C**

  Similar to the cyclical C function a C function can be integrated. This function is executed at a defined time indeed. Allows fast reading, processing and writing of values within one cycle. Function calls at Init/Start/Stop/Exit of the control can also be integrated.

  In u-create studio C++ the project type "Fast Control C Project" serves as example. In this example the cyclical callback functions for fast control and the event callback functions for state transition of the control and its configuration are displayed.

- **Independent C runtime system**

  Allows the integration of a C runtime system into the system which runs independently and can be integrated into the control procedures via Device Service. All tasks must be programmed completely. There is total access to POSIX/Linux and all interfaces provided by Weidmüller.

  In u-create studio C++ the project type "Custom Realtime Runtime System" serves as example. In this example the structural organisation of an independently running C runtime system and the interaction with the control procedure are displayed. Other examples with different functions are: "Executable Communication with the Controller" and "TCP Server Application".

- **Integration of C functions in IEC**

  Allows calling C function in the IEC. The cyclical processing happens within the context of the IEC program.

  In u-create studio C++ the project type "CoDeSys IEC Functions in C" serves as example. In this example the C part which can be called in the IEC is shown.

### 3.6.3 u-create studio Scope

u-create studioScope serves to monitor, record and visualize the values of arbitrary variables in software components. These can be firmware components or application programs (TeachTalk- or IEC-applications). Unlike the debugger, it does not require the program sequence to be interrupted. Tables and diagrams enable visualization of the recorded variable values.

The tool has the following properties:

- Variables and arrays in firmware components and teachtalk- and/or IECprograms can be recorded. The variables must be registered with the sampler.
● Variables can be activated or deactivated from scope. Only activated variables are recorded.
● Events can be used to notify a specific status in the target program.
● Related events can be grouped into classes. Every event is part of a class.
● The actual recording start can be determined via a trigger. The trigger can refer to a variables' value and/or a specific event. Pre- as well as posttriggering is possible.
● Representation of the collected data in different diagrams and views: variable monitor, event monitor, X-t chart, X-Y chart.

Information

Program execution may be slightly delayed while recording with data with u-create studio Scope.

For further information see the online help of u-create studio Scope.

3.7 Libraries and interfaces

Given below is a list of the software interfaces provided by the system.

3.7.1 IEC standard libraries

The following standard libraries are available in u-create studio:
● IEC61131-3 standard libraries
● Access to system functions
● Access to message system
● Diagnosis functions

For further information see the online help of u-create studio.

3.7.2 u-create studio libraries

With the specific libraries the following functions are available amongst other:
● Function blocks for accessing the message system and controller variables
● Function blocks for bus communication
● Function blocks for diagnosis

For further information see the online help of u-create studio.
3.7.3 **OPC UA interface**

The u-create system offers the opportunity to access to IEC variables of the control via an OPC UA interface. Therefore an OPC UA client which must be installed on a PC is needed. OPC UA clients are offered for download in the internet.

To establish a connection with the OPC UA client to the OPC UA server on the control the IP address or the hostname of the control with the port number **4842** first have to be input into the client. If a server has been found the endpoint "None - None" must be selected. Then the connection to the server can be established and the data available on the OPC UA server (variables, functions, ...) are shown. For a detailed description see the help of the OPC UA client.

The server/endpoint URLs delivered of the OPC UA server always contain the hostname. For this reason it must be possible for the OPC UA client to solve the hostname. Some OPC UA clients do not offer his functionality. If this is not the case the control must be inserted manually into the file `C:\Windows\System32\drivers\etc\hosts` on the PC. Therefore a new line with the IP address and the hostname must be added in this file (e.g. 10.150.48.40 <Hostname of control>).

3.7.4 **REST-API (Representational state transfer)**

The u-create system offers the possibility of a visualization connection via REST-API (Representational state transfer) interface. The interface description is available as OpenAPI specification in YAML format.

The API can be accessed via an Internet browser at the following address: `<Control IP address>/api`

The current version of the REST API is displayed via this address. By appending the version to the address, the supported interface is displayed (e.g. 192.68.1.1/api/v3)

The following services are offered and listed as interface file:

- `configuration.yaml`: Specifying basic configurations (e.g. network access, date and time, ...)
- `device-service.yaml`: Executing basic commands of the control (e.g. start, stop, ...)
- `diagnostics.yaml`: Supporting of diagnosis information (e.g. statusreport, ...)
- `license-text.yaml`: Reading "Open Source" license texts of the control
- `licensing.yaml`: Performing licensing (e.g. activating licenses, license overview, ...)
- `report-system.yaml`: Connection to the report system (e.g. reading out error, acknowledge error, ...)
- `update-service.yaml`: Performing a backup or restoring this
- `variables.yaml`: Reading and writing of released variables
By appending the respective file name to the URL, the functions and a description can be read out (e.g. 192.68.1.1/api/v3/configuration.yaml)
4 Operating behavior

4.1 Start-up

The start-up of the PLC is divided into the following main stages:

- Start-up boot system
- Start-up control firmware
- Start-up application

The booting of the control starts automatically as soon as the CPU module is supplied with power. Conditions for the booting are:

- Voltage supply was connected correctly.
- Correctly formatted storage medium with the system software on it is in the slot of the control.
5 Software installation

Information
If a component has already been installed, the automatic installation does not support the new installation of this component. In this case, the respective component must be uninstalled with the help of the individual product Setup or via the operating system.

To install the required u-create components on your PC, proceed as follows:
1) Open the provided installation directory.
2) Open the "Setup" subdirectory.
3) Run the application "setup.exe".
The installation dialog is opened.
4) Follow the instructions in the installation dialog.

Once all components have been installed, there is a link to a directory on the desktop, from where all the necessary components can be started.

Information
All running applications must be completed during the installation process.

5.1 Install firmware of the control

No firmware besides the hardware related software is installed on the control at delivery status. This firmware (without hardware related software) must be loaded to a storage medium via u-create studio and with this storage medium it must be installed on the control.

Therefore an empty storage medium with at least 2 GB memory which is plugged into the PC is needed.

For more information see online help of u-create studio chapter "Create target disk".
6 Configuration

The combined switching of the assemblies and modules in u-create studio that took place during the hardware installation is re-created with the configuration.

The control configuration is based on the device descriptions. These describe the basic configuration specifying which parameterization options are available. The control configuration allows the connection of I/O modules as well as fieldbus modules. Additional elements are available depending on the installed device descriptions.

The available I/O channels are indicated in the u-create studio control configuration and can be utilized in the application.

**Information**

Additional information as well as the exact parameter description of individual modules can be found in the online help of u-create studio.

The network configuration of the control is also possible via Service App "DevAdmin" (see 9 Device Administration (DevAdmin)).

6.1 Data exchange between control and visualization

IEC system variables that have been added to a symbol file can be used by a visualization to display process values and allow operators to modify application variables.

u-create studio makes the so-called symbol file available for the exchange of system variables. The symbol file contains the IEC variables of the u-create studio project.

For detailed information about configuration or data exchange, please see the respective online help (u-create studio).
7 Program development

The control operates based on the following principle: "Read inputs, processing, right outputs". u-control carries out the following tasks during the processing of each task defined with u-create studio:

- Read inputs: At the beginning of the cycle, the current statuses of the inputs are read and written into the process map of the inputs.
- Processing: The application program is executed. The set status of the outputs is copied into the process map.
- Write outputs: At the end of the cycle, the set statuses of the outputs saved in the process map are transmitted to the physical outputs.

Furthermore it is possible to create several applications in parallel or nested and to start them on the control. A variable exchange between the applications is possible. For each application a symbol configuration can be created.

Details about the programming can be found in the online help of u-create studio.

7.1 Task priorities

IEC process priorities for a task can be assigned during programming. By default priority 10 is configured for a task.

The following tables describe the assignment of the IEC task to the mapped linux system task.

Reserved realtime tasks

<table>
<thead>
<tr>
<th>Priority linux</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>99 - 82</td>
<td>Tasks of this priority are reserved for system</td>
</tr>
</tbody>
</table>

High prior real time tasks (default priority 10)

<table>
<thead>
<tr>
<th>Priority linux</th>
<th>Priority IEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>78</td>
<td>1</td>
</tr>
<tr>
<td>75</td>
<td>2</td>
</tr>
<tr>
<td>72</td>
<td>3</td>
</tr>
<tr>
<td>69</td>
<td>4</td>
</tr>
<tr>
<td>66</td>
<td>5</td>
</tr>
<tr>
<td>63</td>
<td>6</td>
</tr>
</tbody>
</table>

Low prior real time tasks

This tasks can be replaced at high workload and run in the linux scheduler "SCHED_FIFO".

<table>
<thead>
<tr>
<th>Priority linux</th>
<th>Priority IEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>7</td>
</tr>
</tbody>
</table>
### Tasks outside real time

This tasks run in the linux scheduler "SCHED_OTHER".

<table>
<thead>
<tr>
<th>Priority linux</th>
<th>Priority IEC</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 (&quot;nice level&quot;)</td>
<td>16 - 31</td>
</tr>
<tr>
<td>0 (&quot;nice level&quot;)</td>
<td>Default linux processes</td>
</tr>
</tbody>
</table>

### 7.2 Fast control

Fast control is used to reduce the system reaction time. This means reading the inputs, processing the data and writing the outputs need less cycles.

![Fig. 7-4: Timing Diagram](image)

The configuration of the fast control happens in the u-create studio (see online help "Configure EtherCAT slave").
7.3 **Device Service**

The DeviceService is a software service that manages, controls and monitors individual programs on the control. The DeviceService can collect and forward information (e.g. error messages) of the programs.

The DeviceService runs as an independent process and starts automatically once the operating system has been fully loaded.

Each program to be managed by the DeviceService must be defined on the control as `DeviceServiceItem`.

### 7.3.1 Defined state model

The DeviceService is responsible for software state transitions that do affect multiple software subsystems running on the same device.

![DeviceService state model]

**States**

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OsReady</td>
<td>The operating system is ready and the Device Service is available. Programs not initialized.</td>
</tr>
<tr>
<td>Stop</td>
<td>The programs are running, Applications not running</td>
</tr>
<tr>
<td>Run</td>
<td>Programs and applications are running</td>
</tr>
</tbody>
</table>

State transitions may be triggered explicitly by software components running on the local device, the operating elements on the device, or by remote clients (e.g. programming tools).

The following commands can be performed by the DeviceService for the state transition of multiple programs on the current device:

<table>
<thead>
<tr>
<th>Command</th>
<th>Command type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Controller</td>
<td>State transition</td>
<td>This status transition is run automatically once the device is started. The status changes from &quot;OsReady&quot; to &quot;Run&quot;.</td>
</tr>
</tbody>
</table>
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Command type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Controller</td>
<td>State transition</td>
<td>The status changes from &quot;OsReady&quot;.</td>
</tr>
<tr>
<td>Start Applications</td>
<td>State transition</td>
<td>The status changes from &quot;Stop&quot; to &quot;Run&quot;.</td>
</tr>
<tr>
<td>Stop Applications</td>
<td>State transition</td>
<td>The status changes from &quot;Run&quot; to &quot;Stop&quot;.</td>
</tr>
<tr>
<td>Init Controller</td>
<td>State transition</td>
<td>The status changes from &quot;OsReady&quot; to &quot;Stop&quot;.</td>
</tr>
<tr>
<td>Shutdown Controller</td>
<td>Special state transition</td>
<td>Closes all running software applications on the device and stops it.</td>
</tr>
<tr>
<td>Reboot Controller</td>
<td>Special state transition</td>
<td>Closes all running software applications on the device and restarts it.</td>
</tr>
<tr>
<td>Delete Applications</td>
<td>Comprehensive Command</td>
<td>Deletes all applications on the device (&quot;reset to factory settings&quot;).</td>
</tr>
<tr>
<td>Restart Controller</td>
<td>Combined state transition</td>
<td>Execute &quot;Stop Controller&quot; followed by &quot;Start Controller&quot;.</td>
</tr>
<tr>
<td>Restart Applications</td>
<td>Combined state transition</td>
<td>Execute &quot;Stop Applications&quot; followed by &quot;Start Applications&quot;.</td>
</tr>
</tbody>
</table>

---

7.3.2 Device Service Item

A Device Service Item represents a program installed on the current device. To do this, a description file called `<itemname>.item` is created in the directory `/opt/deviceservice/items.d/`. The file must be created in Lua (http://www.lua.org). The program must implement a defined status model with defined transitions.

7.3.2.1 Defined state model Device Service Item

Each program (DeviceServiceItem) must implement a status model defined as given below to be managed by the DeviceService.

![DeviceService Item status model](image)

**Fig. 7-6**: DeviceService Item status model
State transitions of the Device Service state model are forwarded to all Device Service Items. So they can perform all actions required to execute their corresponding programs into the requested state.

## States

The program must respond to the following status transitions:

<table>
<thead>
<tr>
<th>Status transition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Init DeviceService</td>
<td>The DeviceService is started and imports all programs created (DeviceService Items)</td>
</tr>
<tr>
<td>Init Controller</td>
<td>The program must execute all the necessary initializations and then change to the Stop process</td>
</tr>
<tr>
<td>Start Applications</td>
<td>The program begins processing and must change to the Run status</td>
</tr>
<tr>
<td>Stop Applications</td>
<td>The program ends processing and must change to the Stop status</td>
</tr>
<tr>
<td>Exit Controller</td>
<td>The program must end all initializations carried out in &quot;Init Controller&quot; and change to the OS-Ready status.</td>
</tr>
<tr>
<td>ExitDeviceService</td>
<td>The DeviceService ends all programs and itself</td>
</tr>
</tbody>
</table>

Commands that are forwarded to the programs can be found in chapter "Defined State Model".

### 7.3.2.2 Creating a description file

Each program to be managed by the DeviceService must be created containing the following elements and the functions described above, via a description file.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name of the program (DeviceServiceItem)</td>
</tr>
<tr>
<td>variables</td>
<td>Global variables of the program</td>
</tr>
<tr>
<td>defaultvariables</td>
<td>Global variables with default values that can be overwritten</td>
</tr>
</tbody>
</table>

The system provides the following global variables (defaultvariables) with default values that can be overwritten by the program:

<table>
<thead>
<tr>
<th>Global variable</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>systemPath</td>
<td></td>
<td>Directory where the control software is stored.</td>
</tr>
<tr>
<td>applPath</td>
<td>/opt/kecontrolapplication/</td>
<td>Directory where applications are created and loaded</td>
</tr>
<tr>
<td>workPath</td>
<td>/opt/kecontrolapplication/</td>
<td>Directory in which the application can store data</td>
</tr>
<tr>
<td>autorestart</td>
<td>false</td>
<td>Defines whether or not the system restarts following an error</td>
</tr>
</tbody>
</table>
Each DeviceServiceItem can export configuration variables or use configuration variables exported by other DeviceServiceItem. Variables are exported by adding them to the global variables variable:

```plaintext
variables = {
    someVar = 12,
    otherVar = 'text'
}
```

Example file example.item.ex:

```plaintext
item = {
    name = "example"

    variables = {

    }
}

defaultvariables = {
}

-- TESTTRANSITION -----------------

  testtransition = function(transition)
  -- Init DeviceService --
  if transition == "Init DeviceService" then
    return true
  -- Exit DeviceService --
  elseif transition == "Exit DeviceService" then
    return true
  -- Init Controller --
  elseif transition == "Init Controller" then
    return true
  -- Exit Controller --
  elseif transition == "Exit Controller" then
    return true
  -- Start Applications --
  elseif transition == "Start Applications" then
    return true
  -- Stop Applications --
  elseif transition == "Stop Applications" then
    return true
  end
  return false
end

-- DOTRANSITION -----------------

dotransition = function(transition, step)
  -- Init DeviceService
  if transition == "Init DeviceService" then
    if step == 1 then
    elseif step == 2 then
    elseif step == 3 then
    elseif step == 4 then
    elseif step == 5 then
    elseif step == 6 then
    elseif step == 7 then
    elseif step == 8 then
```

<table>
<thead>
<tr>
<th>Global variable</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>starepPathTmp</td>
<td>/tmp/</td>
<td>Directory where the files of the status report are stored</td>
</tr>
<tr>
<td>maxStarepCount</td>
<td>5</td>
<td>Number of stored status reports</td>
</tr>
<tr>
<td>autostart</td>
<td>true</td>
<td>Defines whether or not the programs are to be run immediately after the control is started</td>
</tr>
<tr>
<td>autostartTimeout</td>
<td>5</td>
<td>Time in which the autostart can be canceled [s]</td>
</tr>
</tbody>
</table>
elseif step == 9 then
elseif step == 10 then
end
--Exit DeviceService--
elseif transition == "Exit DeviceService" then
  if step == 1 then
  elseif step == 2 then
  elseif step == 3 then
  elseif step == 4 then
  elseif step == 5 then
  elseif step == 6 then
  elseif step == 7 then
  elseif step == 8 then
  elseif step == 9 then
  elseif step == 10 then
end
--Init Controller--
elseif transition == "Init Controller" then
  if step == 1 then
  elseif step == 2 then
  elseif step == 3 then
  elseif step == 4 then
  elseif step == 5 then
  elseif step == 6 then
  elseif step == 7 then
  elseif step == 8 then
  elseif step == 9 then
  elseif step == 10 then
end
--Exit Controller--
elseif transition == "Exit Controller" then
  if step == 1 then
  elseif step == 2 then
  elseif step == 3 then
  elseif step == 4 then
  elseif step == 5 then
  elseif step == 6 then
  elseif step == 7 then
  elseif step == 8 then
  elseif step == 9 then
  elseif step == 10 then
end
--Start Applications--
elseif transition == "Start Applications" then
  if step == 1 then
  elseif step == 2 then
  elseif step == 3 then
  elseif step == 4 then
  elseif step == 5 then
  elseif step == 6 then
  elseif step == 7 then
  elseif step == 8 then
  elseif step == 9 then
  elseif step == 10 then
end
--Stop Applications
elseif transition == "Stop Applications" then
  if step == 1 then
  elseif step == 2 then
  elseif step == 3 then
  elseif step == 4 then
  elseif step == 5 then
  elseif step == 6 then
  elseif step == 7 then
  elseif step == 8 then
  elseif step == 9 then
  elseif step == 10 then
end
, --- DOCHECK -----------------------------
docheck = function()
docheck
end
Program development

7.3.3 Defined operation behaviour

Each DeviceServiceItem (program) can provide the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Inputs</th>
<th>Return value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>testtransition</td>
<td>Status transition</td>
<td>true / false</td>
<td>Used to test whether the required status transition can be carried out by the program.</td>
</tr>
<tr>
<td>dotransition</td>
<td>Status transition, step number</td>
<td>-</td>
<td>Execute one step of a certain transition.</td>
</tr>
<tr>
<td>docheck</td>
<td>-</td>
<td></td>
<td>Checks that the program is working correctly.</td>
</tr>
<tr>
<td>dostatusreport</td>
<td>Path</td>
<td></td>
<td>Adds files to the status report currently triggered.</td>
</tr>
<tr>
<td>doclearretain</td>
<td>-</td>
<td></td>
<td>Deletes process of the retain files of the applications managed by the program.</td>
</tr>
<tr>
<td>dodeleteapplication</td>
<td>-</td>
<td></td>
<td>Deletes process of applications managed by the program.</td>
</tr>
</tbody>
</table>

Before each status transition, the DeviceService calls the testtransition function with the required status transition. This checks that the DeviceServiceItem is able to change its status. The function must return either true or false. No other value is permitted.

The DeviceService then calls the function dotransition with the status transition and a step number being carried out. Each DeviceServiceItem must execute the status transition. If an error occurs in this process, the DeviceServiceItem must call the Lua standard function error to be able to enter the error message with the DeviceService. The dotransition function is not permitted to have a return value.

The DeviceService checks for error messages. If an error has occurred in the DeviceServiceItem, the entire system is powered down. Depending on the configuration, the control automatically starts back up in the Run status.

The DeviceService performs a cyclical check by calling the docheck function to ensure that the registered DeviceServiceItem is working correctly.

The status report is a collection of information of all programs running on the control at a specific point in time. When a status report is triggered, all DeviceServiceItem are informed so that their information can be appended to the status report.
7.3.4 Status report

The status report is a collection of information software sub-systems running on a device at a specific point in time. If a status report is triggered, all `DeviceServiceItem` are informed so that this information can be added to the status report.

7.3.5 Co-routine model

`DeviceServiceItem` callbacks are run as Lua co-routines. This makes it possible to delay the running of a `DeviceServiceItem` by calling `coroutine.yield()`. This is preferable to a delay loop in the Lua script or intermediate solutions such as calling sleep functions using the operating system library.

Other co-routine functions are not permitted to be used.
8 Licensing

In some cases, Weidmüller products must be licensed in order to enable use of the full scope of functions. By default, products are delivered with a "trial license". This means that a product's complete scope of functions can be used in full for a defined, limited period. During this period, a valid license must be requested from Weidmüller in order to be able to use the purchased functions for an unlimited period. To do so, please contact Weidmüller.

The following license types are possible:

- Single-user license for software products on the PC. This only applies to the PC where the software product was installed.
- Runtime license for software products on the device. These only apply to the devices where the software was installed.
- Trial license: License with limited validity period.

To license a Weidmüller product, a valid license ticket and a PC with an Internet connection are always required.

**Information**

Never get rid of your license ticket! The ticket is absolutely necessary in order to activate the license or deactivate/reactivate it in case of a device replacement.

In order to license the software product on the currently installed device (PC or control), the license (from the license ticket) must be activated. A license can only be activated once. Afterward, the software is bound to that device and can only be used in its full scope there. If device replacement is necessary in case of service, the activated license can be unlocked and then reactivated in the event of a PC replacement. When replacing a device, it is not possible to return the license, but the license can be restored on the new device. This is possible up to 2 x. Afterward, Weidmüller must be contacted.

8.1 Trial license

By default, all products are delivered with a trial license. This license expires after 30 days. Within this period, all product functions can be used in their full scope. After this time has expired, use is no longer possible, or only possible to a limited extent. For full use, a new, valid license is required, which can be requested from Weidmüller.

A trial license can only be used once. Even if the product is uninstalled and then reinstalled, use without a valid license is no longer possible.

8.1.1 Activation of a trial license (single user license)

When using a product on a PC, no activation of the trial license is necessary. Once the product has been installed, the trial license is automatically activated and the product can be used for 30 days from the time of installation.
8.1.2 Activation of a trial license (runtime license)

When using a device, the trial license must be activated manually. Otherwise, the product cannot be used or can only be used incompletely. Activation is only possible via the access "DevAdmin".

Information

Before activation, the date and time must be set correctly on the device! Otherwise, the license may become invalid immediately when the date is updated.

To activate the trial license proceed as follows:

1) Start "DevAdmin"
2) Establish a connection to the desired device.
3) Switch to tab Licensing ► Activation.
4) Click on Activate trial license.

The trial license has been activated and the product is fully usable for 30 days.

8.2 Activating a single-user license (software on the PC)

The following options are available for activating a license on the PC:

- Online activation

To activate the license, the "CodeMeter" license management tool from WIBU Systems (https://www.wibu.com/de.html) is required on the PC of the tool to be licensed. The tool is automatically installed during setup. (If the tool has been uninstalled manually, it can be re-downloaded on the manufacturer's side and reinstalled.)

Online activation

If the PC with the installed tool to be licensed has an Internet connection, online activation is possible. Activation takes place on this PC.

To do so, proceed as follows:

1) Open "WebDepot" by entering the link listed on the license ticket into an Internet browser on the PC
2) Enter the ticket code and click on Next.
3) Click on **Activate Licenses**.
4) If necessary, select the license for the desired product.
5) Click on **Activate Selected Licenses now**, and the licensing process is executed.

6) Confirm the dialog with OK.

The license has been successfully activated.

### 8.3 Activating a runtime license (software on the device)

The following options are available for activating a license on the device:

- Online activation using "DevAdmin"

#### Online activation using "DevAdmin"

For this online activation, a PC with an Internet connection is required. The device on which the software to be licensed is installed does not require an Internet connection, but it must be connected to the PC via a network connection.

Proceed as follows to activate the license:
1) Establish a connection between the PC and the device using DevAdmin.

2) Click on Licensing ► Online Activation.

3) Enter the ticket code.

4) Click on Start online activation.

The license was successfully activated on the device.

---

### 8.4 License status and license overview

#### Single-user licences

The status of a software license can be queried by clicking the icon in the task bar. Furthermore, a licensing overview can be called up using the link to the WebAdmin. In the License monitor tab, the license number and the number of assigned and available licenses are displayed. A license overview of all licenses and corresponding validity periods is located in the Container tab.

#### Runtime licenses

In order to query the status of a hardware license (runtime license), the device has to be accessed via "DevAdmin". In the Licensing ► Overview tab, an overview of all licenses and their validity periods as well as the license type is shown.

---

### 8.5 Device replacement

If device replacement is necessary in case of service, the activated license can be unlocked and then reactivated in the event of a PC replacement. When replacing a device, it is not possible to return the license, but the license can be restored on the new device. This is possible up to 2 x. Afterward, Weidmüller must be contacted.

#### 8.5.1 PC replacement (single-user license)

The following options are available in which a license that has already been activated can be transferred to a new PC:

- Moving the license (Rehost): The existing PC is still functional. The license can be moved, i.e. returned to the old/ existing PC and reactivated on the new PC.
Licensing

- Reactivation the license (restore): The existing PC is no longer functional and can no longer return the license.

In any case, the PCs must have an Internet connection.

**Moving the license (Rehost)**

Using this option, a license is transferred from an old, functional PC to a new PC. Both PCs have Internet access.

In order to transfer a software license that has already been activated to a different PC, proceed as follows:

1) Open "WebDepot" by entering the link listed on the license ticket into an Internet browser on the old PC.
2) Enter the ticket code and click on **Next**.
3) Click on **Re-Host Licenses**
4) If necessary, select the license for deactivation.
5) Click on **Deactivate Selected Licenses Now**.
6) Confirm the dialog with OK.

The entered license is available for licensing again and can be used as described in Chap. "Licensing software on the PC".

**Reactivation the license (restore)**

In this case, the PC with the activated license is no longer functional, so returning the license is not possible. The new PC has Internet access.

To be able to reuse the license, first contact the Weidmüller Service department. The Weidmüller Service department authorizes the repeat activation of the license.

In order to activate the reactivated license on a new PC, proceed as follows:

1) Open "WebDepot" by entering the link listed on the license ticket into an Internet browser.
2) Enter the ticket code and click on **Next**.
3) Click on **Re-Store Licenses**.
4) Accept the restore conditions.
5) Click on **Restore Selected Licenses Now**.

The reactivated license was successfully activated on the PC.

**Information**

*Depending on the system, the button Re-Host Licenses is always displayed in the Web Depot. Clicking on this button triggers an error message, i.e. Re-Host Licenses cannot be used to reactivate the license.*

---

### 8.5.2 Device replacement (runtime license)

The following options are available in which a license that has already been activated can be transferred to a new device:

- Online restore of a license using DevAdmin
- Offline restore of a license using DevAdmin

The original license runs on the new device for an additional 14 days. The license can only be used 2 x on a new device.

**Online restore of a license using DevAdmin**

For restoring a license online, there is a PC with an Internet connection in the network of the device and it is running. The device to be licensed is also running.

1) Establish a connection between the PC and the device using DevAdmin.
2) Click on **License ► Online Restore**.
3) Click on **Start license Restore process**.
4) Confirm the dialog with **OK**.

The entered license is available for licensing again and can be used as described in Chap. "Licensing software on a device".

---

### 8.6 Reset the license information

In certain cases it is necessary to reset all license information of a device (e.g. if a restore fails). The license previously used on the device gets invalid and can no longer be reactivated.

To reset all license information of a device proceed as follows:

1) Establish a connection between the PC and the device using DevAdmin.
2) Click on **Licensing ▶ Reset.**
3) Click on **Remove license data**

4) Confirm the dialog with **OK.**

The license information of the device has been reset. To re-license the device, a new license must be purchased. Please contact the Weidmüller service.
Device Administration (DevAdmin)

If a PC is within the network of the control, the login dialog for the DevAdmin can be opened on it via opening a internet browser and inserting the address http://<IP address of the control>. The user is logged in with the following login data:

Username: Administrator
Password: tobechanged

The DevAdmin has the following tabs:

- **Diag.**: Read informationen of the control, trigger state report or crash report
- **Config.**: Perform network, time, and time zone settings
- **Backup/Restore**: Create or import a backup
- **Licensing**: Perform licensing, see 8 Licensing
- **Legal Info**: Display of (open source) license texts of all installed software packages
- **Plugins**: Display of installed extensions

9.1 Tab "Diag."

This tab is divided into the following areas:

- Device Information
- Device State
- Statereport
- Crashreport
Area "Device Information"

In this area the following information of the used control are displayed:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Designation of the control</td>
</tr>
<tr>
<td>Ser.No.</td>
<td>Serial number of the control</td>
</tr>
<tr>
<td>Part No.</td>
<td>Material number of the control</td>
</tr>
<tr>
<td>Rev.</td>
<td>Revision number of the control</td>
</tr>
<tr>
<td>Operating Hours</td>
<td>Operating hours of the control</td>
</tr>
<tr>
<td>Workload</td>
<td>Current utilization of the control</td>
</tr>
<tr>
<td>Temperature</td>
<td>Current temperature of the control</td>
</tr>
<tr>
<td>Battery</td>
<td>State of the battery</td>
</tr>
</tbody>
</table>

Area "Device State"

In this area the following information of the used control are displayed:
### Area "Statereport"

In this area a state report can be triggered via **Create statereport on device**. The report is saved under `/masterdisk/protocol/statusreport`. The report also contains the diagrams from the long-term recording ("Monitor" tab).

Via the dropdown menu a state report can be selected and downloaded to the PC.

### Area "Crashreport"

Via the dropdown menu a crash report can be selected and downloaded to the PC.

### 9.2 Tab "Config."

This tab is divided into the following areas:

- Network Hostname
- Interface Ethernet0
- Time, Date and Timezone
- Long-term Diagnostic Monitor
In the area "Hostname" the following settings can be done:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname</td>
<td>Host name of the control</td>
</tr>
</tbody>
</table>

In the area "Interface Ethernet0" the following settings can be done:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Activate or deactivate DHCP</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the control</td>
</tr>
<tr>
<td>Netmask</td>
<td>Set subnet mask</td>
</tr>
<tr>
<td>Gateway</td>
<td>Set gateway</td>
</tr>
<tr>
<td>DNS-Server 1</td>
<td>Set DNS server 1</td>
</tr>
<tr>
<td>DNS-Server 2</td>
<td>Set DNS server 2</td>
</tr>
</tbody>
</table>

![Fig. 9-8: DevAdmin - Configuration](image)
Area "Time, Date and Timezone"

In the area "Time, Date and Timezone" the following settings can be done:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Set clock</td>
</tr>
<tr>
<td>Date</td>
<td>Set date</td>
</tr>
<tr>
<td>Area</td>
<td>Select region</td>
</tr>
<tr>
<td>City/Zone</td>
<td>Select city</td>
</tr>
</tbody>
</table>

Area "Long-term Diagnostic Monitor"

In the area "Long-term Diagnostic Monitor" you can activate or deactivate the long-term recording of device data.

9.3 Tab "Backup/Restore"

The tab "Backup/Restore" is divided into the following areas:

- Backup to removeable storage
- Restore from removeable storage

![Fig. 9-9: DevAdmin - Backup/Restore](image)

Area "Backup to removeable storage"

In this area the following information of the used device are displayed:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Destination of the Backups (not editable)</td>
</tr>
</tbody>
</table>

Area "Restore from removeable storage"

In this area the following information of the used device are displayed:
### 9.4 Tab "Plugins"

In the "Plugins" tab, the extensions installed later are displayed. This chapter describes how to create a plugin. Then the example of the monitor plugin is used to explain which information can be retrieved in the "Plugins" tab.

#### 9.4.1 Add plugin to DevAdmin

There are the following ways to add own content under the Plugins tab:

- Content as HTML files
- Content hosted on a separate server

The files to be displayed under the "Plugins" tab must be stored on the control in the directory `/opt/devadmin/plugins/<name>`. There must always be a configuration file named `config.json`. In this file necessary configurations are specified.

**Information**

A data exchange between DevAdmin and own content is not possible.

**Specification of configuration file**

The file `config.json` contains the following configuration entries.

<table>
<thead>
<tr>
<th>Entry</th>
<th>Type / Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pluginType</td>
<td>iFrame</td>
<td>Plugin type</td>
</tr>
</tbody>
</table>
### Entry | Type / Value | Description
--- | --- | ---
{iFrame.type} | file or link | Type of integration (file: HTML files, link: server)
iFrame.path | STRING | For file: Relative path specification of index.html from base directory
iFrame.url | STRING | For link: URL of server
iFrame.port | 0 - 65535 | For link: Port of server
fullScreen | BOOL | Not available yet
displayName | STRING | Display name in the dropdown list under "Plugins"

#### Content as HTML files

The start file must have the name `index.html` and be specified in the configuration file. Structure of the configuration file `config.json`:

```json
{
    "pluginType": "iFrame",
    "iFrame": { 
        "type": "file",
        "path": "html/index.html"
    },
    "fullScreen": false,
    "displayName": "My new Plugin"
}
```

#### Content hosted on a separate server

Structure of the configuration file `config.json`:

```json
{
    "pluginType": "iFrame",
    "iFrame": { 
        "type": "link",
        "url": "https://myserver.com/",
        "port": 1880
    },
    "fullScreen": false,
    "displayName": "Server Plugin"
}
```

### 9.5 Change password for DevAdmin

At the top right of the DevAdmin is the user menu which contains the **Change password** entry.
If this is clicked, the window opens in which the password for the **DevAdmin** can be changed.

![DevAdmin - Change Password](image)

**Fig. 9-10: DevAdmin - Change Password**

The following data are inserted into the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New password:</td>
<td>New password</td>
</tr>
<tr>
<td>Confirm password:</td>
<td>Confirm the new password</td>
</tr>
</tbody>
</table>

Via **OK** the new password is applied.
Via **Cancel** the procedure gets aborted.
10 Software units

Within the system it is possible to assemble user-specific software or additional independent extensions ("features") as a software unit and mount them in the u-create studio as an optional package when creating a new target ("Create target").

The software unit must be created for the desired target system and stored as its own directory in the path of the Software Service service. To do this, click on the icon of the Software Service in the right area of the task bar and open the location via the context menu "Open Software Service Path".

The directory name of the software unit must be composed as follows:

<name>_<version>_<Target platform>

Example: softwareunitdemo_1.0_arm

10.1 Creating a software unit

Each software unit must contain at least one repository and one description file (meta.xml). This is the only way to use the automatic installation and uninstallation process of Debian-based control software.

![Software Unit Diagram]

Fig. 10-11: Structure

**Description file "meta.xml"**

The file is the description of the software unit. This contains general information (such as name, version, description,...).

We recommend that you create a separate directory in the software unit directory for each repository within a software unit.
The name under the tag <name> is specified as package name in the "Optional Packages" dialog. The description under the tag <description> is displayed as additional text below.

The installable repository is specified under the tag <data>.

**Repository**

A repository must contain installable packages (e.g. *.deb files) and make the sources main, contrib and non-free available.

Each software unit may only contain exactly one repository for exactly one target system (e.g. Repository target="Debian" type="Full").

A list of the packages contained in the repository can be defined. Each package has a unique identifier (Identifier string and InstallPackage string) that can be used by installation programs.

Each repository must contain a meta-packet that has exactly the same Identifier string as the entire software unit.

Normally, a Debian package must be signed with a "gpg" key. By default, the Debian-based control system only contains the public "gpg" key of the Weidmüller software units. If a software unit is installed that is signed with a user-specific "gpg" key, an authentication warning is written to the installation log file.

**Information**

*If only individual files are to be copied to the controller, it is recommended that they are also included in a package. This is the only way to ensure clean management (installation, uninstallation, update).*

**MD5 checksum**

We recommend that you generate an MD5 checksum for repositories. This must be entered in the meta.xml file.

**Information**

*The checksum must consist of lowercase letters.*

### 10.2 Example meta.xml

This chapter shows an example description file meta.xml.

```xml
<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<SoftwareUnit>
  <DateTime>2017-09-25 10:48:20</DateTime>
  <Name>
    <DefaultString>Software unit demo</DefaultString>
    <LocalizedString culture="de">Software Unit Demo</LocalizedString>
    <LocalizedString culture="en">Software unit demo</LocalizedString>
  </Name>
</SoftwareUnit>
```
Software units

<Name>
<Description>
<DefaultString>Sample for custom software unit</DefaultString>
<LocalizedString culture="de">Beispiel für personalisierte Software unit</LocalizedString>
<LocalizedString culture="en">Sample for custom software unit</LocalizedString>
</Description>
<Identifier>softwareunitdemo</Identifier>
-Version>1.0</Version>
<Capabilities>
<Provides>
<Feature version="1.0" identifier="softwareunitdemo" />
</Provides>
<Requires> </Requires>
</Capabilities>
<Data>
<Repositories>
<Repository type="Full">
<Path>repository</Path>
<AvailablePackages>
<Package>
{Name>
<DefaultString>Software unit demo</DefaultString>
<LocalizedString culture="de">Software Unit Demo</LocalizedString>
<LocalizedString culture="en">Software unit demo</LocalizedString>
</Name>
<Description>
<DefaultString>My Software unit 1</DefaultString>
<LocalizedString culture="de">Meine Software Unit 1</LocalizedString>
<LocalizedString culture="en">My software unit 1</LocalizedString>
</Description>
<InstallPackage>swunitdemopacket1</InstallPackage>
<Identifier>softwareunitdemo</Identifier>
</Package>
</AvailablePackages>
</Repository>
</Repositories>
</Data>
</SoftwareUnit>
11 OPC UA Server

The OPC UA Server can be installed as an optional software package (see "Software Units"). This chapter describes the use of the OPC UA Server on Weidmüller controls with the Linux operating system.

OPC Unified Architecture (OPC UA) is a standard for manufacturer-independent networking of devices in the automation sector. This provides standardized access options to the control. This standard allows any program (e.g. an OPC UA client) that supports this standard to communicate with the Weidmüller control and access data. For general information see: www.opcfoundation.org

Overview

The OPC UA Server runs in addition to the applications on the control and allows OPC UA clients to connect.

![Fig. 11-12: Overview](image)

Installation

The OPC UA Server can be installed on the control as an optional package via a target removable storage device. In the selection dialog, you can specify whether the OPC UA Server also accepts unencrypted connections.

For further information, please refer to u-create studio online help.

11.1 Overview of variants

The following table provides an overview of the product versions and their functionalities.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>OPC UA Server</th>
<th>OPC UA Server Pro</th>
<th>OPC UA Server Adv</th>
</tr>
</thead>
<tbody>
<tr>
<td>SecureChannel:</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Number of simultaneous client connections (sessions):</td>
<td>1</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>User authentication:</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Services as per table below:</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
### 11.2 Establishing a connection

The OPC UA Server supports the establishment of connections to OPC UA standard compliant clients via TCP-IP binary protocol. The IP address of the control is also the IP address of the OPC UA server. The port is 4842 by default. Application-specific settings such as port, application name, manufacturer, etc. can be set via the server configuration u-create studio.

**Example of a connection call:**

opc.tcp://ServerUrl:Port
Free and licensed OPC UA clients are available on the Internet for testing the functionality of the OPC UA Server. The endpoint URLs of the OPC UA Server returned by the Discovery service always contain the host name of the controller. The OPC UA Client must be able to resolve the host name when connecting to the Server IP (e.g. via host file or DNS).

**Information**

*The host name must never begin with a digit, otherwise problems may occur during server boot-up or connection setup.*

If the Discovery service returns an error code, there is either a network problem or it was not possible to start the server correctly. More detailed error sources can be found in Server Logging, see 11.6 Logging of server operation.

If the OPC UA Server finds expired licenses or no licenses at all during the connection setup (ActivateSessionRequest), the OPC UA error code BadLicenseNotAvailable is returned. It is not possible to set up a connection.

The OPC UA Server supports the following connection types:

- Unencrypted connection
- Encrypted connection via certificate

**Unencrypted connection**

If unencrypted connections have been configured at the time of installation, the OPC UA server can be accessed with the OPC UA client via an unencrypted connection. The registration can be done anonymously or by username and password. An anonymous client has full access to all nodes and network data.

In the user administration the user "Administrator" is created with the password "tobechanged" as standard. The OPC UA Server accepts all users created in the user administration.

**Information**

*The use of an unencrypted connection during operation is strongly advised against as this represents a major security risk due to possible unauthorized access. The unencrypted connection should therefore only be used for development purposes.*

**Encrypted connection**

With an encrypted connection, both OPC UA Server and OPC UA Client must authenticate each other. This is done via a "public-key" procedure using certificates. Basic256Sha256 (Sign, Sign & Encrypt) is used as the encryption algorithm. (For further literature on the certificate mechanism, see e.g. OPC Foundation Website.)
The OPC UA Server automatically creates the following directories on the controller in the directory `/opt/kecontrolapplication/OpcUa/PKI/CA:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/own</td>
<td>Contains the secret server key and the server certificate.</td>
</tr>
<tr>
<td>/trusted/certs</td>
<td>Contains all trusted client certificates.</td>
</tr>
<tr>
<td>/trusted/crl</td>
<td>Contains all revoked certificates (Certificate Revocation List). These clients can no longer connect.</td>
</tr>
<tr>
<td>/issuers/certs</td>
<td>Contains all trusted certificates used for verification.</td>
</tr>
<tr>
<td>/issuers/crl</td>
<td>Contains all revoked certificates (Certificate Revocation List), used for verification.</td>
</tr>
<tr>
<td>/rejected</td>
<td>Contains all client certificates rejected by the server. These clients cannot connect.</td>
</tr>
</tbody>
</table>

The OPC UA Server generates a server certificate (uaserverc.der) during startup. Instead of the automatically generated server certificate, you can also use your own generated certificate, which has to be stored in the directory `/opt/kecontrolapplication/OpcUa/PKI/CA/own`. This certificate must be known to each OPC UA client that wants to authenticate itself to the OPC UA server.

Only connection requests from OPC UA clients whose certificate is stored in the `/trusted/certs` directory are accepted. If a client connects to the server and its certificate is unknown, the connection setup is rejected and the rejected certificate is stored in the `/rejected` directory.

After the client and server have successfully authenticated themselves, user authentication with user name and password is also essential.

### 11.3 Server configuration

In this chapter the configurations of the OPC UA server are described. These can be made via "Expert entries" in the u-create studio. All OPC UA configurations must be listed in the `[OpcUa]` section. Configuration changes only become effective after restart.

#### Application-specific configurations

The following application-specific settings can be configured:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Server port</td>
</tr>
<tr>
<td>ApplicationName</td>
<td>Application name</td>
</tr>
<tr>
<td>ApplicationURI</td>
<td>Application URI</td>
</tr>
<tr>
<td>ProductURI</td>
<td>Product URI</td>
</tr>
<tr>
<td>ProductName</td>
<td>Product name</td>
</tr>
<tr>
<td>ManufacturerName</td>
<td>Manufacturer name</td>
</tr>
</tbody>
</table>
### ShowVariableTree

Display of generic variable tree (1 = activated, 0 = deactivated)

#### Example

```
[OpcUa]
[OpcUa.Application]
Port=4840
ApplicationName="SampleApplicationName"
ApplicationURI="SampleApplicationURI"
ProductName="OPC-UA Server"
ManufacturerName="Sample Manufacturer"
ShowVariableTree = 1 // 1 = activate, 0 = deactivate
```

### SecureChannel configurations

With an encrypted connection, the Basic256Sha256 encryption algorithm is supported with 2 different setting options (Sign and Sign and Encrypt). All configuration values can be configured via integer values.

<table>
<thead>
<tr>
<th>Security Policy</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic256Sha256</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message Mode</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign</td>
<td>1</td>
</tr>
<tr>
<td>Sign and Encrypt</td>
<td>2</td>
</tr>
</tbody>
</table>

#### Information

The "Basic256" and "Basic128Rsa15" encryption algorithms are no longer supported because they no longer meet current security requirements.

#### Example (default setting)

```
[OpcUa]
// Policy 3 = Basic256Sha256
// MessageMode 1 = Sign, 2 = SignAndEncrypt
Policy=3
MessageMode=1
Policy=3
MessageMode=2
```

Additional communication channels (CommunicationChannel) with different security settings can be added. Each additional connection is declared with an ascending number. The number must be unique. The Policy and MessageMode entries must always be set for each connection.

### Subscription configuration

For the "Subscription" service, the supported time intervals can be configured. By default, 50 ms is set for the minimum and 3 600 000 ms for the maximum limit.
Possible configuration entries:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MinPublishingInterval</td>
<td>Minimum time interval in milliseconds, data type Double</td>
</tr>
<tr>
<td>MaxPublishingInterval</td>
<td>Maximum time interval in milliseconds, data type Double</td>
</tr>
</tbody>
</table>

**Information**

The minimum time interval chosen should not be too small, since the OPC UA server can reach a high load by answering these requests if there are several clients.

When sending a request (CreateSubscription), the client submits a desired time interval. The server checks whether the required interval is within the configured limits. If this is not the case, the limit value set is rejected by the server.

**Example**

```
[OpcUa.Subscription.Publishing]
MinPublishingInterval=100.50 // double
MaxPublishingInterval=10000.50 // double
```

The client requests an interval of 70 ms. The server responds that only a time interval of 100.5 is possible.

**Recording values (samples)**

The default recording intervals are set to 50 ms, 100 ms, 250 ms, 500 ms, 1000 ms, 2500 ms and 5000 ms. The intervals can be changed via the configuration, the data type is Integer:

```
[OpcUa.Subscription.Publishing]
Interval=100 // int32 - ms
Interval=20 // int32 - ms
Interval=500 // int32 - ms
```

Several recording intervals can be defined by increasing the interval number. Every interval number must be unique.

When sending a request (CreateMonitoredItem), the client submits a desired recording interval. The server checks whether the required interval is within the configured limits. If this is not the case, the closest value set is returned by the server.

**Example 1 (Standard configuration)**

Standard recording intervals: 50 ms, 100 ms, 250 ms, 500 ms, 1000 ms, 2500 ms and 5000 ms

The client requests an interval of 70 ms. The server answers that the monitored object (MonitoredItem) recorded at intervals of 50 ms.

**Example 2 (example configuration)**

Configured recording intervals: 20 ms, 100 ms, 500 ms
The client requests a sampling interval of 70 ms. The server answers that the monitored item (MonitoredItem) recorded at intervals of 100 ms.

11.4 Generic variable tree

The generic variable tree is used to display the system variables of the IEC application and can be activated / deactivated via the expert entry ShowVariableTree (in u-create studio). By default, the generic variable tree is deactivated.

```
[OpcUa]
[OpcUa.Application]
ShowVariableTree = 1 // 1 = activate, 0 = deactivate
```

After activating the generic variable tree and restarting the controller, the generic variable tree is located in the directory Root/Objects (NodeId: Name space URI = "KeControlOpcUa/KeControlVar", Numeric ID = 0, DisplayName = "KeControl Variables").

The generic variable tree is an image of the KeStudioU4 u-create studio Variable Browser. The directory structure consists of the root nodes APPL, in which the approved IEC variables are located, and SYS, which contains the data of the system configuration. With the exception of SYS.CAT, all variable browser data are also visible in the OPC UA Server. The application and configuration data are displayed using object nodes (FolderType) and variable nodes. The node ID of the node is always of type String and is derived from the path of the data. All nodes are created in the "KeControlOpcUa/KeControlVar" namespace.

Example

The boolean application variable VarBool under APPL.system has the node ID "APPL.system.VarBool" and the OPC UA data type Boolean.

Arrays and structures are created in the generic variable tree using directories and individual variable nodes for the elements. All variable nodes offer read and write access (Attribute AccessLevel). Whether or not read and write operations work depends on the underlying data source. Approved system variables of the IEC in the APPL directory now support read and write access. Certain system configurations, however, cannot be overwritten. In case of an unauthorized write access, a corresponding error code is returned.

11.5 Creating an information model

The OPC UA Server supports the ability specified in the standard to create an information model via an XML file. This means that the OPC UA Standard address space can be expanded by adding a customer-specific information model. You can also define the structure for displaying the data.
All OPC UA information (variables, data types, methods, etc.) is displayed as nodes. Each node is assigned to a namespace. Namespaces and node IDs allow a unique identification. You can define your own namespaces, object and variable instances in the XML file. Methods, types (reference, object, variable, data types) or views are not supported.

The information must be defined in exactly one XML file and this file must be stored on the control in the directory /appldisk/application/OpcUa/. No other XML files may be located in this directory. When the server is started up, the XML file is read out and the defined information model is created. Adaptations in the XML file only become effective after restart.

If the XML file contains errors (e.g. incorrect syntax, incorrect data type assignment), the OPC UA server does not start. Clients cannot connect anymore. The cause of the error can be examined more closely in the System Trace. See chapter 11.6 Logging of server operation.

**Namespaces**

A namespace is uniquely identified by its URI. This URI corresponds to a numeric index assigned by the OPC UA server during startup. The namespace "http://opcfoundation.org/UA/" (index = 0) is already specified by the OPC UA standard and contains predefined data types and nodes for OPC UA server diagnostics.

Namespaces are described within the XML tag `<NamespaceUris>`. Several namespaces can be created there using `<Uri>`. The following attributes are permissible:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ns</td>
<td>This attribute is used to assign the numeric index of the namespace URI used within the XML file. Only namespace 0, predefined by the OPC UA standard, can be used without explicit XML configuration. The numeric index is reassigned by the OPC UA server at runtime. This index can be read out using the &quot;NamespaceArray&quot; object.</td>
</tr>
<tr>
<td>isDefaultNs</td>
<td>You can use this attribute to specify a namespace as the default value within the configuration file. When describing instances, this namespace no longer has to be specified explicitly in the definition of the NodeId. Only one standard namespace can be used.</td>
</tr>
</tbody>
</table>

In the following example, two namespaces are created:

```xml
<NamespaceUris>
  <Uri ns="1" isDefaultNs="1">www.company.com</Uri>
  <Uri ns="2">MyNamespace</Uri>
</NamespaceUris>
```

**Object and variable instances**

To display variables or methods in the OPC UA client, instances must be created and linked to the desired variables and methods on the control.
**Information**

Currently not all data types defined in the OPC UA standard are supported.

The following table describes the supported OPC UA data types with the corresponding IEC data types. The unique node address that must be used when creating in the XML file is specified for each data type. The node address consists of multiple so-called "BrowseNames". BrowseName is an OPC UA concept that can be used to specify node addresses. A BrowseName consists of a namespace index and a name. In the XML definition, these are separated by a colon. The BrowseNames are compiled into a node address in XML separated by a period. The node addresses for the standard data types are specified by the OPC UA standard and can be read out from the address space using a client.

The node address for a Boolean variable is defined as follows, for example: `0:Types.0:DataTypes.0:BaseDataType.0:Boolean`. In the table below, the node addresses are displayed in abbreviated form. However, for each node address, in the XML file the following character string must be appended at the front: `0:Types.0:DataTypes.0:BaseDataType`.

<table>
<thead>
<tr>
<th>OPC UA data type</th>
<th>IEC data type</th>
<th>Node address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>BOOL</td>
<td>0:Boolean</td>
</tr>
<tr>
<td>SByte</td>
<td>SINT</td>
<td>0:Number.0:Integer.0:SByte</td>
</tr>
<tr>
<td>Byte</td>
<td>BYTE, USINT</td>
<td>0:Number.0:UInteger.0:Byte</td>
</tr>
<tr>
<td>Int16</td>
<td>INT</td>
<td>0:Number.0:Integer.0:Int16</td>
</tr>
<tr>
<td>UInt16</td>
<td>WORD, UINT</td>
<td>0:Number.0:UInteger.0:UInt16</td>
</tr>
<tr>
<td>Int32</td>
<td>DINT</td>
<td>0:Number.0:Integer.0:Int32</td>
</tr>
<tr>
<td>UInt32</td>
<td>DWORD, UDINT</td>
<td>0:Number.0:UInteger.0:UInt32</td>
</tr>
<tr>
<td>Int64</td>
<td>LINT</td>
<td>0:Number.0:Integer.0:Int64</td>
</tr>
<tr>
<td>UInt64</td>
<td>LWORD, ULINT</td>
<td>0:Number.0:UInteger.0:UInt64</td>
</tr>
<tr>
<td>Float</td>
<td>REAL</td>
<td>0:Number.0:Float</td>
</tr>
<tr>
<td>Double</td>
<td>LREAL</td>
<td>0:Number.0:Double</td>
</tr>
<tr>
<td>String</td>
<td>STRING, WSTRING</td>
<td>0:String</td>
</tr>
<tr>
<td>DateTime</td>
<td>DATE_AND_TIME, DATE, TIME_OF_DAY</td>
<td>0:DateTime</td>
</tr>
</tbody>
</table>

**Information**

The mapped data types between OPC UA and IEC must match, otherwise a node is not generated.
The OPC UA data types `BaseObjectType (0:Types.0:ObjectTypes.0:BaseObjectType)` and `FolderType (0:Types.0:ObjectTypes.0:BaseObjectType.0:FolderType)` can be used to build a hierarchical model.

All instances are collected under a `Instances` entry. This entry needs an attribute, `Parent`, which defines the root node of the following instances as a node address. The `Instances` entry can be defined multiple times in succession. The root node must exist, as otherwise no child nodes can be generated.

The following example shows the instantiation of two directories within the `Objects` node predefined by the OPC UA standard. The node hierarchy is determined by the hierarchy of the XML entries.

```xml
< Instances Parent="0:Objects">
  < Object
      DataType="0:Types.0:ObjectTypes.0:BaseObjectType.0:FolderType"
      NodeId="1:i=1000" BrowseName="Folder" DisplayName="Folder">
    < Object
      DataType="0:Types.0:ObjectTypes.0:BaseObjectType.0:FolderType"
      NodeId="1:i=1001" BrowseName="Subfolder" DisplayName="Subfolder">
      <!-- define further objects or variables .... -->
    </Object>
  </Object>
</ Instances>
```

For the object instantiation, the XML entry `Object` is used, while for variables, the XML entry `Variable` is used. The following attributes have to be specified for both tags:

- **DataType**
- **NodeId**
- **BrowseName**
- **DisplayName**

The description of the node IDs (NodeId) always consists of a namespace index together with the specification of an identifier. The identifiers have to be specified numerically (i=xx). Variables also need a value and, optionally, an access right (attribute `AccessLevel`). The value of the variable can either be set by a constant, which is defined by the `ValueConstant` attribute, or by the path of a system variable, defined by the `ValuePath` attribute.

Possible XML attributes:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>DataType</code></td>
<td>Node address of the required data type for the instance. The node address of the types can be read out of the address space with the help of an OPC UA client, if necessary.</td>
</tr>
</tbody>
</table>
**Attribute** | **Description**
--- | ---
NodeId | Defines the node ID of the current instance, and this must be unique. This server version only supports numeric node IDs.
BrowseName | Internally used name for node addresses.
DisplayName | Displayed name for the OPC UA client.
AccessLevel (only variables) | Defines the access rights for the `Value` attribute of a variable. By default, no access is allowed. The attribute is specified as hexadecimal number and interpreted as `AccessLevelType` defined in the OPC UA specification 3. Example: "0x01" = CurrentRead, "0x03" = CurrentRead and CurrentWrite.
ValueConstant (only variables) | Allocation of a constant.
ValuePath (only variables) | Path to a system variable. The path can be displayed in the u-create studio browser after successful login.

In the following example, an OPC UA Boolean-type variable is instanced in the server address space and linked to a variable on the controller. When defining the Node ID, the namespace index was not specified in the example. This uses the default namespace (if `NamespaceUris` is defined in the entry).

```
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean"
    NodeId="i=1002" BrowseName="MyBool" DisplayName="MyBool"
    ValuePath="APPL.system.vBOOL" AccessLevel="0x01"/>
```

Instead of a variable path, constants defined in the XML file can also be linked. All data types specified above are supported, except `DateTime`.

In the following example, an OPC UA Boolean-type variable is instanced and the value is linked to a constant:

```
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean"
    NodeId="i=1003" BrowseName="MyBool" DisplayName="MyBool"
    ValuePath="true" AccessLevel="0x03"/>
```

### Arrays

**Information**

The OPC UA Server supports only one-dimensional arrays with basic data types and variable mapping (Attribute `ValuePath`).

For instantiating arrays, another entry, `ArrayDimension`, and the following additional attribute is needed:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ValueRank=&quot;1&quot;</td>
<td>Determines the number of array dimensions. Only the value &quot;1&quot; is supported.</td>
</tr>
</tbody>
</table>

In the following example, the entire IEC array is instantiated in the server as an OPC UA array.

```
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean"
    NodeId="i=10" BrowseName="bool array" DisplayName="bool array"
    AccessLevel="0x03" ValueRank="1"/>
```
Optionally, a subrange of an array can be specified for variable mapping. The following attributes are required for this:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArrayOffset</td>
<td>Specifies the start value of the array subrange (left index).</td>
</tr>
<tr>
<td>ArrayLength</td>
<td>Desired length of the array subrange.</td>
</tr>
</tbody>
</table>

In the following example, a subrange of the IEC array is instantiated in the server as an OPC UA array. In the IEC an array from 1 to 100 is defined. In the OPC UA server only the sector from 10 to 15 is mapped.

```xml
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean"
            NodeId="i=10" BrowseName="bool array" DisplayName="bool array"
            AccessLevel="0x03" ValueRank="1">
  <ArrayDimension ArrayOffset="9" ArrayLength="5"
                   ValuePath="APPL.system.vBoolArray"/>
</Variable>
```

**Example of a complete XML file**

```xml
<OpcUAInformationModel>
  <!-- Declaration of namespace URIs -->
  <NamespaceUris>
    <Uri ns="1" isDefaultNs="1">http://www.company.com</Uri>
    <Uri ns="2">MyNamespace</Uri>
  </NamespaceUris>
  <!-- Declaration of instances -->
  <!-- add child instances to parent Root/Objects node -->
  <Instances Parent="0:Objects">
    <!-- create folder My Variables -->
    <Object DataType="0:Types.0:ObjectTypes.0:BaseObjectType.0:FolderType"
             NodeId="1:i=1000" BrowseName="My Variables" DisplayName="My Variables">
      <!-- add a UInt8 variable to My Variables folder -->
      <Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:UInteger.0:Byte"
                 NodeId="1:i=1003" BrowseName="MyUInt8" DisplayName="MyUInt8"
                 ValuePath="APPL.system.vUSINT" AccessLevel="0x03"/>
      <!-- variable is read- and writeable -->
      <Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:UInteger.0:UInt16"
                 NodeId="1:i=1004" BrowseName="MyUInt16" DisplayName="MyUInt16"
                 ValuePath="APPL.system.vUINT" AccessLevel="0x03"/>
      <Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:UInteger.0:UInt32"
                 NodeId="1:i=1005" BrowseName="MyUInt32" DisplayName="MyUInt32"
                 ValuePath="APPL.system.vUDINT" AccessLevel="0x03"/>
      <Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:UInteger.0:UInt64"
                 NodeId="1:i=1006" BrowseName="MyUInt64" DisplayName="MyUInt64"
                 ValuePath="APPL.system.vULINT" AccessLevel="0x03"/>
    </Object>
  </Instances>
</OpcUAInformationModel>
```

<!-- variable is only readable -->
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:Integer.0:Int16" NodeId="1:i=1009" BrowseName="MyInt16" DisplayName="MyInt16" ValuePath="APPL.system.vINT" AccessLevel="0x01"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:Integer.0:Int32" NodeId="1:i=1010" BrowseName="MyInt32" DisplayName="MyInt32" ValuePath="APPL.system.vDINT" AccessLevel="0x01"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:Integer.0:Int64" NodeId="1:i=1011" BrowseName="MyInt64" DisplayName="MyInt64" ValuePath="APPL.system.vLINT" AccessLevel="0x01"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:Float" NodeId="1:i=1013" BrowseName="MyFloat" DisplayName="MyFloat" ValuePath="APPL.system.vREAL" AccessLevel="0x03"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Number.0:Double" NodeId="1:i=1014" BrowseName="MyDouble" DisplayName="MyDouble" ValuePath="APPL.system.vLREAL" AccessLevel="0x03"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean" NodeId="1:i=1016" BrowseName="MyBool" DisplayName="MyBool" ValuePath="APPL.system.vBOOL" AccessLevel="0x03"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:DateTime" NodeId="1:i=1017" BrowseName="MyDateTime" DisplayName="MyDateTime" ValuePath="APPL.system.vDATE_AND_TIME" AccessLevel="0x03"/>

<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:String" NodeId="1:i=1018" BrowseName="MyString" DisplayName="MyString" ValuePath="APPL.system.vSTRING" AccessLevel="0x03"/>

<!-- string constant -->
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:String" NodeId="1:i=1020" BrowseName="String Constant" DisplayName="String Constant" ValueConstant="My test string constant" AccessLevel="0x03"/>

<!-- int32 constant -->
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:String" NodeId="1:i=1021" BrowseName="Int32 Constant" DisplayName="Int32 Constant" ValueConstant="12" AccessLevel="0x03"/>

<!-- float constant -->
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:String" NodeId="1:i=1022" BrowseName="Float Constant" DisplayName="Float Constant" ValueConstant="12.47" AccessLevel="0x03"/>

<!-- create a subfolder for arrays -->
<Object DataType="0:Types.0:ObjectTypes.0:BaseObjectType.0:FolderType" NodeId="1:i=1023" BrowseName="1-dim Arrays" DisplayName="1-dim Arrays"/>

<!-- boolean array - block mapping -->
<Variable DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean" NodeId="1:i=1024" BrowseName="bool array" DisplayName="bool array" AccessLevel="0x03" ValueRank="1" ValueConstant="true" ArrayDimension ArrayOffset="0" ArrayLength="2" ValuePath="APPL.system.vBoolArray"/>

</Object>
Role-based authorization model

The OPC UA Server supports the assignment of access rights for users based on user roles. These access rights only apply to the nodes defined in the XML file and when the client logs on with a user name and password. An anonymous client has full access to all nodes.

In the user administration, users and roles must be created and one or more roles assigned to the users. The role names in XML must match the names in the user administration. When an OPC UA client connects to the server, the server accesses the user administration to read the authentication data and roles of the client. Authorizations are assigned to the created roles in XML. These rights only apply to the nodes instantiated by the XML. If rights for roles have already been assigned in the user administration, these are not considered by the OPC UA Server. Before each request, the OPC UA Server checks whether the roles of the user meet the requirements for access rights.

If access to values of variable nodes is desired, the access permissions set for the respective variable node (AccessLevel attribute) are also checked beforehand. If, for example, the value of a variable node is not writable, the client cannot execute a write command, even if the authorizations are given based on the role assignment.

Global rights

Before variables and objects can be instantiated (XML Instances entry), roles and authorizations must be assigned globally. The permissions are defined as bitmasks and correspond to access type (PermissionType), defined in the OPC UA specification, Part 3.

With a terminating zero, a role name can only be a maximum of 128 characters long. A maximum of 30 different roles are supported. The authorizations are interpreted as hexadecimal numbers. The prefix "0x" is optional. Upper and lower case of the hex number (0xAABB or 0xaabb) is not taken into account.

Example

The following code extract shows the definition of 2 roles with rights. The role "Observer" can run through the tree and only has read access to the instanced nodes. The "Operator" role can also write.

```xml
<DefaultRolePermissions>
  <RolePermission RoleName="Observer" Permissions="0x21"/> <!-- Bit 0 - Browse, Bit 5 - Read -->
  <RolePermission RoleName="Operator" Permissions="0x61"/> <!-- Bit 0 - Browse, Bit 5 - Read, Bit 6 - Write -->
</DefaultRolePermissions>
```

A user without roles or with roles that were not defined globally in XML only has access to the standard address space of OPC UA and the variable tree. The same applies if no global role has been defined in XML. If a user has several roles, all the rights of the roles are taken into account.
**Node-based XML rights**

The globally declared authorizations of a role can be extended or restricted for each node.

The following example overwrites the authorization of the "Operator" role for the "Var1" variable node. In the global authorization definition "Browse", the role "Operator" can perform read and write accesses. For the "Var1" variable node the access to browse and read is now restricted.

```xml
<Variable
    DataType="0:Types.0:DataTypes.0:BaseDataType.0:Boolean" NodeId="i=5000"
    BrowseName="Var1" DisplayName="Var1" AccessLevel="0x03" ValueRank="1">
    <NodeRolePermissions>
        <RolePermission RoleName="Operator" Permissions="0x21"/>
    </NodeRolePermissions>
</Variable>
```

### 11.6 Logging of server operation

The OPC UA server protocols information and errors about startup and execution at runtime. This information is either integrated into the general logging of the control and thus displayed in the trace monitor (in the u-create studio) or managed by the server as a separate file. This file is stored on the controller in the directory `/opt/kecontrol/protocol/OpcUa/`. The messages outputs here can provide useful information, in particular, for troubleshooting during information model creation (incorrect variable mapping, typing errors, already existing NodeIds, etc.).

Logging can be configured via expert entries (in u-create studio). If there is a general logging of the control, only the `TraceMask` parameter is taken into account. If a separate file is managed, the `TraceFileSizeKbMax` parameter can be additionally specified.

The value of the `TraceMask` configures the granularity of the output and is executed as a bit field. By default, the configuration is set to `TraceMask = 5`. The value to be set results from the bitwise addition of the following partial masks:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Partial mask</th>
<th>Logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>Startup information and error, configured by default</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>More detailed information and error output during startup</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>Runtime error (internal failures e.g. memory bottleneck, unexpected types for read/write etc.), configured by default</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>Detailed output about runtime errors</td>
</tr>
</tbody>
</table>

The `TraceMask` is interpreted as a decimal number. To activate all outputs, the `TraceMask` can be set to the value `-1`.

The `TraceFileSizeKbMax` parameter specifies the maximum file size in kB. The default value is 4096 kB. Once the maximum size has been reached, a further log file with suffix `.1` is created. The log files are then overwritten.

**Example**
[OpcUa]
[OpcUa.Trace]
TraceMask = 15
TraceFileSizeKbMax = 4096
12 **Node-RED**

Node-RED can be installed as an optional software package (see Software Units). It is a graphical development tool developed by IBM. This allows function modules, so-called "nodes", to be lined up in a certain sequence by drawing connections. Each function module has a defined task. Data can be processed and transferred between the function modules.

The graphical editor of Node-RED can be started via "DevAdmin" in the tab "Plugins". Further information on the functionality of Node-RED can be found in the internet. See also https://nodered.org/.
13 LongtermDiagnosticMonitor

The LongtermDiagnosticMonitor can be installed as an optional software package (see Software Units) and offers the possibility of long-term recording of data on the control. Via "Monitor" in the DevAdmin (tab Plugins) the data can be displayed.

13.1 Monitor

The monitor plugin is divided into the following areas:

- Problems
- Groups
- Categories

**Overview**

<table>
<thead>
<tr>
<th>Problems</th>
<th>Groups</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical (0)</td>
<td>localhost</td>
<td>disk (d w m y)</td>
</tr>
<tr>
<td>Warning (0)</td>
<td></td>
<td>main (d w m y)</td>
</tr>
<tr>
<td>Unknown (0)</td>
<td></td>
<td>network (d w m y)</td>
</tr>
</tbody>
</table>

![Fig. 13-13: DevAdmin - Monitor](image)

**Problems**

In this area the occurring faults divided to their priority are displayed.

**Groups**

In this area all available diagrams are listed and can be selected.

**Categories**

In this area the categories for the long-term diagnostic are listed. After choosing a category, the corresponding diagrams are displayed. These diagrams are also saved when triggering a status report.

Beside the category, the daily overview \(d\), the weekly overview \(w\), the monthly overview \(m\) or the yearly overview \(y\) can be called via the corresponding letters \(d\ w\ m\ y\). An overview with 4 diagrams consisting of daily, weekly, monthly and yearly overview is opened through clicking on a diagram.

The following diagrams can be displayed:
<table>
<thead>
<tr>
<th>Category</th>
<th>Diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Average latency for /dev/sda</td>
<td>Average waiting time (latency) for access to the directory /dev/sda. The waiting time shows how utilized the system is. 1 second waiting time corresponds to an utilization of 100 %.</td>
</tr>
<tr>
<td></td>
<td>Disk IOs per device</td>
<td>Inputs and outputs on the data carrier per device</td>
</tr>
<tr>
<td></td>
<td>Disk latency per device</td>
<td>Waiting time on the data carrier</td>
</tr>
<tr>
<td></td>
<td>Disk throughput for /dev/sda</td>
<td>Throughput of the data carrier for the directory /dev/sda [in Byte per second]</td>
</tr>
<tr>
<td></td>
<td>Disk utilization for /dev/sda</td>
<td>Utilization of the data carrier for the directory /dev/sda. If an input/output takes 1 second, the data carrier is 100 % utilized.</td>
</tr>
<tr>
<td></td>
<td>IOs for /dev/sda</td>
<td>Number of inputs/outputs (I/O requirements) per second and their average size [in kB] (in the diagramm corresponds 1 kB = 1000 Byte).</td>
</tr>
<tr>
<td></td>
<td>Throughput per device</td>
<td>Throughput of inputs/outputs for directory /dev/sda</td>
</tr>
<tr>
<td></td>
<td>Utilization per device</td>
<td>Utilization of directory /dev/sda [in percent]</td>
</tr>
<tr>
<td>munin</td>
<td>Munin processing time</td>
<td>Processing time of the four different Munin-processes (munin update, munin graph, munin html, munin limits) [in seconds]</td>
</tr>
<tr>
<td></td>
<td>Munin update</td>
<td>Time needed by Munin-processes for collecting the recorded data [in seconds]</td>
</tr>
<tr>
<td>network</td>
<td>Firewall Throughput</td>
<td>Throughput of the firewall [received and forwarded packages per second]</td>
</tr>
<tr>
<td></td>
<td>Netstat</td>
<td>TCP activity of all network interfaces. Number of active, passive, failed, re-booted and current performed TCP connections per second.</td>
</tr>
<tr>
<td></td>
<td>ETH0 errors</td>
<td>Number of errors, package losses and collision on the ETH0 network interface.</td>
</tr>
<tr>
<td></td>
<td>ETH0 traffic</td>
<td>Data traffic of the ETH0 network interface [in bits per second]</td>
</tr>
<tr>
<td></td>
<td>ETH1 errors</td>
<td>Number of errors, package losses and collision on the ETH1 network interface.</td>
</tr>
<tr>
<td></td>
<td>ETH1 traffic</td>
<td>Data traffic of the ETH1 network interface [in bits per second]</td>
</tr>
<tr>
<td>Category</td>
<td>Diagram</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>overview</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU utilization</td>
<td>Overall utilization of the CPU per core</td>
<td>[in percent]</td>
</tr>
<tr>
<td>Disk lifetime</td>
<td>Remaining lifetime of the flash storage media</td>
<td>[in percent]</td>
</tr>
<tr>
<td>Disk space</td>
<td>Used and free memory on the flash storage</td>
<td>media [in MB]</td>
</tr>
<tr>
<td>PLC baselib heap memory</td>
<td>Used and free memory on the “BaseLib Heap”</td>
<td>storage media [in MB]</td>
</tr>
<tr>
<td>statistics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAM usage</td>
<td>RAM utilization divided in occupied, free</td>
<td>and available [in MB]</td>
</tr>
<tr>
<td>System task performance</td>
<td>Distribution of computing power (per core)</td>
<td>for the different process groups [in percent]</td>
</tr>
<tr>
<td>on core n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature information</td>
<td>Temperature of CPU and mainboard [in degree</td>
<td>Celsius]</td>
</tr>
<tr>
<td>Uptime of PX-Package</td>
<td>Power-on time of control packages (PX package)</td>
<td>[in days]</td>
</tr>
<tr>
<td><strong>processes</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fork rate</td>
<td>Number of rebooted processes [per second]</td>
<td></td>
</tr>
<tr>
<td>Number of threads</td>
<td>Number of threads</td>
<td></td>
</tr>
<tr>
<td>Processes</td>
<td>Number of processes divided into their state</td>
<td></td>
</tr>
<tr>
<td>Processes priority</td>
<td>Number of processes divided into their</td>
<td>importance</td>
</tr>
<tr>
<td>VMstat</td>
<td>Utilization of CPU time through processes</td>
<td>[in milli = thousandth]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>system</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available entropy</td>
<td>Number of available random numbers</td>
<td></td>
</tr>
<tr>
<td>CPU usage</td>
<td>CPU utilization divided in different process</td>
<td>groups</td>
</tr>
<tr>
<td>File table usage</td>
<td>Number of opened files and maximum number of</td>
<td>opened files</td>
</tr>
<tr>
<td>Individual interrupts</td>
<td>Number of interrupts divided in type of</td>
<td>interrupt</td>
</tr>
<tr>
<td>Inode table usage</td>
<td>Number of opened inodes</td>
<td></td>
</tr>
<tr>
<td>Interrupts and context</td>
<td>Number of interrupts and context switches</td>
<td></td>
</tr>
<tr>
<td>switches</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load average</td>
<td>Average load, which shows the number of</td>
<td>directly executable processes</td>
</tr>
<tr>
<td>Logged in users</td>
<td>Logged-in users</td>
<td></td>
</tr>
<tr>
<td>Memory usage</td>
<td>Display, which shows where the main memory</td>
<td>is used [in bytes]</td>
</tr>
<tr>
<td>Swap in/out</td>
<td>Transfer between main memory and swap-memory</td>
<td></td>
</tr>
<tr>
<td>Uptime</td>
<td>Power-on time</td>
<td></td>
</tr>
</tbody>
</table>
14 Data recorder

Using the data recorder, variable values can be recorded on the control during runtime.

Access to the data recorder is possible via the following interfaces:

- Library "KREC" for IEC applications (real-time access) in u-create studio
- "DataRecApi" interface for C applications

For additional information, refer to the online help for u-create studio.

A data recorder has to be created and configured by the application first. This is possible via the IEC application or using u-create scope.

14.1 Configuration

Within an IEC application, one (or more) data recorders can be created and configured. The necessary configurations (properties, variables, etc.) are compiled and stored in what is known as a "profile".

The basic properties of a profile are the following:

- Maximum number of variables
- Buffer capacity
- Buffer type
- Persistence

Maximum number of variables

Every variable whose value is to be recorded must be registered with the data recorder. This requires the complete path of the variable. The maximum number of variables defines the upper limit for the number of variable registrations. Variables can be registered and deregistered, but the number cannot exceed the specified number of variables.

Only variables with the following data types can be registered with the data recorder:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Data Type</th>
<th>Data Type</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>REAL</td>
<td>LREAL</td>
<td>BYTE</td>
</tr>
<tr>
<td>ENUM</td>
<td>WORD</td>
<td>DWORD</td>
<td>LWORD</td>
</tr>
<tr>
<td>SINT8</td>
<td>SINT16</td>
<td>SINT32</td>
<td>SINT64</td>
</tr>
<tr>
<td>ENUM_SINT8</td>
<td>ENUM_SINT16</td>
<td>ENUM_SINT32</td>
<td>ENUM_SINT64</td>
</tr>
<tr>
<td>UINT8</td>
<td>UINT16</td>
<td>UINT32</td>
<td>UINT64</td>
</tr>
<tr>
<td>ENUM_UINT8</td>
<td>ENUM_UINT16</td>
<td>ENUM_UINT32</td>
<td>ENUM_UINT64</td>
</tr>
<tr>
<td>DATE</td>
<td>DATE64us</td>
<td>TIME</td>
<td>TIME64us</td>
</tr>
<tr>
<td>DT</td>
<td>DT64us</td>
<td>TOD</td>
<td>TOD64us</td>
</tr>
</tbody>
</table>
**Buffer capacity**

The buffer capacity defines the maximum number of stored variable values with a time stamp that a profile can store. The recording process reads out the values of all registered variables and writes these into the buffer of the profile along with a time stamp. This data record (variable value with time stamp) is called "Sample".

The buffer capacity multiplied by the maximum number of variables determines the storage requirement of a profile. The memory must be created beforehand in order to ensure recording in real time.

**Buffer type**

The following types of buffers can be configured:

- **Continuous** (endless recording): Recording beyond the buffer capacity is possible by starting from the beginning once again after the last entry. It is possible that overwriting unread samples may result in the loss of data. When reading data, data should be checked for completeness.

- **SingleShot** (individual recording): no recording beyond the buffer capacity. At the latest, the recording ends when the end of the buffer is reached. No data loss, no verification of the completeness of read data necessary.

**Persistence**

By default, configurations and stored data are not kept after the system is restarted. However, this can be changed by configuring the data recorder.

The following configurations are possible:

- **No persistence**: Each time the application starts-up, the profile is newly created by the application and the recording starts with an empty buffer.

- **Persistence of the configuration**: The profile settings are stored in a file under the path `{System.applPath}/application/control/config`. In the course of the start-up of the control, the profile is automatically created according to the configuration. The recording starts with an empty buffer. The data is not persistently stored. If the `autoStart` option is selected when the profile is created for the first time, recording is automatically started during start-up.

- **Full persistence**: All information (configuration, as well as data that is already recorded) is persistently stored. The state and data are binary-stored in the directory `{System.applPath}/retain`. In the course of the start-up, the profile is automatically created according to the configuration, and is put into the state that it was at the last point in time a save operation was carried out. If the `autoStart` option is selected, the recording continues.

With regard to the persistence, the following shall be observed:
When the profile state is being stored, large amounts of data can accrue, depending on the size of the profile. If the application stores the state cyclically at frequent intervals, this can significantly reduce the service life of non-volatile storage. After the application controls the storage of the states themselves, a sensible compromise should be sought here.

Changes to the application can cause persistent settings of a profile to become invalid if they reference variables that no longer exist. Invalid settings, such as faulty trigger variables, result in the profile no longer being able to be configured as it was originally. The application discovers this through corresponding error messages. If, however, there are only individual variables that are missing that have been registered for recording, the profile is configured with the available variables as being ready-to-use (and, if necessary, also started).

If a profile is deleted, its persistent data is also deleted (configuration and recording status). If the queue is deleted, the persistent recording status is also deleted.

14.2 Data recording

Variables that are registered to a profile can be recorded. A recording consists of:

- capturing the values of all registered variables and
- the storage thereof (together with metadata) in the buffer.

The recording of the variables can be controlled in terms of time or event. The data is stored in a buffer in conjunction with a time stamp. The buffer is located in the RAM, but it can also be stored on a data carrier. The buffer can be read out area by area, even during a running recording.

Recording can take place either manually or automatically. During automatic recording, the following can be configured by means of the application:

- Temporal distance of the individual recordings in μs
- Task priority of the individual recordings (from 1 = high to 31 = low)
- CPU task binding (starting from 0, or -1, for system-side selected standard binding, > 1 CPU available for the runtime)

With these settings, a task is generated on the system side, which is queued under the usual application tasks in regards to intermittency and priority.

**Information**

The interaction of these tasks with the usual application tasks must be taken into account. For example, if the time stamps of the data detect unwanted “jitter,” the adopted configuration should be modified. Furthermore, the priority should not be too high, the distance should not be too short and the quantity of data should not be too large in order to prevent a blocking of real-time-critical tasks.

A profile can occupy the following states:
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recording</td>
<td>A recording is carried out.</td>
</tr>
<tr>
<td>stopped</td>
<td>The recording is stopped or ended.</td>
</tr>
<tr>
<td>waiting</td>
<td>The start trigger or start delay is waited upon before the recording is car-</td>
</tr>
<tr>
<td></td>
<td>ried out.</td>
</tr>
</tbody>
</table>

**Recording mode**

The following recording types are possible:

- **Standard**: the values of all variables are stored per individual recording
- **Change-based**: The values of all variables are stored upon a change of a certain variable

A change-based recording does not monitor all variables of the profile, but rather only a specific variable. If its value changes, the values of all profile variables is are recorded. Optionally, the recording of the values with respect to the detection of a change can be reduced in importance.

**Example**

Change-based recording with a monitored variable \texttt{prodCnt} and a reduction of the storage by a factor of 2, only the values that are written in bold are stored.

<table>
<thead>
<tr>
<th>prod-Cnt</th>
<th>1</th>
<th>1</th>
<th>2</th>
<th>2</th>
<th>3</th>
<th>3</th>
<th>4</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>weight</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>14</td>
<td>15</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>tmp</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>61</td>
<td>61</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

**Information**

The initial sampling of a variable since its registration with a profile always results in it being stored, since the variable value is in any case applied as being changed.

**Quantity limits**

It is relevant for some applications that recordings should not run endlessly, but instead should be automatically stopped after a defined number of recordings. Furthermore, it may be sensible not to begin the recording immediately after start-up, but rather only after a certain time frame (especially if a trigger actuates the start and relevant data is only available a little while after the trigger).

For this purpose, the following limits can be set:

- **Start delay**: Defined number of calls after recording start, that do not generate any recordings. Only after this quantity are the variable values recorded.
- **Number of the recordings to be stored**: Number of calls (without start delay) until the recording is automatically stopped.
Start and stop trigger

Triggers are conditions, which can cause a recording of a profile to be started or stopped in an event-driven manner. A trigger condition always refers to a certain variable. This does not have to be registered in the profile, but rather is specified via its complete path in the variable tree. The same limits apply for the data type as for registered variables. The following types of conditions can be specified with these variables:

- Exceeding of a constant threshold value $t$: The condition occurs when the variable value $t$ is exceeded, while upon the previous call, this was not yet the case.
- Falling short of a constant threshold value $t$: The condition occurs if the variable value $t$ is fallen short of, while upon the previous call, this was not yet the case.
- Exceeding or falling short of a constant threshold value $t$: OR a combination of both of the above conditions
- Any change of the value of the variable: The condition occurs if the variable value has changed with respect to the last call

Upon the occurrence of the start trigger condition, the recording begins corresponding to the configuration (in other words, either endless or until the end of the buffer is reached). If a stop trigger condition has been configured, the recording is stopped upon the occurrence of this condition.

A start trigger condition can also be set without an associated stop trigger condition. The converse is not possible.

Furthermore, there is the option to define a stop time condition (post-start trigger). This defines a number of recordings. Afterwards, the recording is stopped automatically.

Example

Total capacity: 32 samples, stop time condition: 25 % (= 8 samples)
**Information**

*For the assessment of the stop time capacity as a percentage, it shall be observed that in the case of the “continuous” buffer type, the buffer capacity is rounded up system-internally to the next power of two (e.g. 4000 is rounded up to 4096). The percentage has an effect on the value that is rounded up to.*

In order to record data before the occurrence of the start trigger, a start time must be configured in the application (pre-start trigger recording). In this case, the buffer is filled immediately after the recording start. Upon the occurrence of the start trigger, the recording continues as part of the stop time condition, or the recording stops if a stop time condition has not been configured.

![Diagram](image)

1 ... Recording start  
2 ... Start trigger  
3 ... Recording stop  
4 ... Start time  
5 ... Stop time

| Total capacity: 32 samples | Stop time: 25% = 8 samples, max. start time: 75% = 24 samples |

**Information**

*For start time and stop time conditions, the writing position is stored in the profile at the point in time the trigger condition occurred. These positions remain available until the next recording.*

The start time and/or stop time condition overwrites the following configurations:

- The start time rescinds the start delay
- The start time or stop time rescinds the stop trigger
- The stop time rescinds the number limitation

**Effectiveness of settings**

All settings carried out using set and remove functions always take effect upon the next time a recording is started. Ongoing recordings are not immediately influenced by set and remove calls.
Exceptions include the login and logoff of variables. These functions also have an effect while a recording is ongoing, thereby enabling a dynamic configuration of variables without interrupting value processes.

14.3 Reading out the buffer

You can read out the samples stored in the buffer of a profile at any time, even during an ongoing recording. Each profile carries a write position on which the next individual recording will be stored. This position can be prompted.

Example

When using triggers, the positions at which a call has detected the occurrence of the corresponding trigger condition are delivered.

When using a start and stop trigger, the difference between the delivered trigger positions is the number of the recorded samples minus 1, because the stop position designates the position of the sample that was recorded most recently.

The read functions enable the reading out of any buffer areas, whereby an area is indicated by start position and sample number.

Example

In order to enable step-by-step reading, a position is also delivered in addition to data, which can be used as a start position upon the next call.

In addition to the delivered read positions, reserved positions for the oldest and newest samples are provided for first time reading.

Example

Start position: Oldest sample
Example

Start position: Newest sample

The validity of a reading position is limited in the context of the buffer type "Continuous". Upon reaching the end of the buffer, the write index breaks down, by which existing samples are overwritten. The read functions detect when a start position refers to samples which meanwhile have been overwritten. In this case the requested data cannot be delivered. The output parameter then contains correspondingly fewer values for actually delivered samples. The delivered reading position for subsequent calls refers to the current buffer state.

14.4 Recording callback from the application

For some applications, it may be sensible to combine the recording of process variables in data recorders with process-oriented testing and/or further processing. Over the course of each individual recording, a variable is read only one time, but the value can be used for several actions.

For this purpose, a data indicator can be registered, which is called up at the end of an individual recording and receives the result of the recording as arguments as well as the data indicator from the registration. The recording includes the following information:

- Time stamp of the sample
- Recording position
List of the stored samples of variables, consisting of variable ID and variable value

All information is available as read only. They are stored in the profile buffer before the application function call. For one thing, data fidelity is thus ensured, and for another thing, the intermittency of the recording is independent of fluctuations that develop as a result of irregular run times of the application function.

**Information**

The application function should have the shortest and the most constant runtime possible. In the event that an automatic recording has been configured for the profile, it must not contain any blocking calls, since unlimited wait times have negative impacts on the recording of other profiles.

### 14.5 Data locality and real-time

The variable server concept, on which the data recording in profiles is based, is defined across processes. That means that variables are physically distributed to different system processes. The determinism of data recordings thus depends on the data locality: Access to process-local variables lasts shorter, while access to remote variables by means of interprocess communication lasts longer.

In order to achieve the highest possible determinism for real-time-relevant recordings, process-local variables that are of a real-time quality should not be registered in the same profile together with remote variables. In lieu of this, it is recommended to separate profiles of a real-time quality – which may possibly also scan in shorter cycles and higher priority – from the remaining profiles.

### 14.6 Size limitations

In consequence of the current technical implementation for 32 bit systems (max. 4 GB virtual address space, max. 32 bit), the following theoretical limitations apply in terms of the amount of data:

<table>
<thead>
<tr>
<th>Max. buffer capacity</th>
<th>Max. number of variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>524,288</td>
<td>1</td>
</tr>
<tr>
<td>262,144</td>
<td>2</td>
</tr>
<tr>
<td>131,072</td>
<td>4</td>
</tr>
<tr>
<td>65,536</td>
<td>8</td>
</tr>
<tr>
<td>32,768</td>
<td>16</td>
</tr>
<tr>
<td>16,384</td>
<td>32</td>
</tr>
<tr>
<td>8,192</td>
<td>64</td>
</tr>
<tr>
<td>4,096</td>
<td>128</td>
</tr>
</tbody>
</table>
**Max. buffer capacity**       **Max. number of variables**

| 2,048          | 256          |

**Example**

Profiles with between 32,769 and 65,536 samples can register a max. of 8 variables for recording.

Profile with SingleShot buffer type

<table>
<thead>
<tr>
<th>Max. buffer capacity</th>
<th>Max. number of variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,048,576</td>
<td>254</td>
</tr>
<tr>
<td>1,042,453</td>
<td>256</td>
</tr>
</tbody>
</table>

Profiles with a maximum capacity of 1,048,576 can register a max. of 254 variables for recording. Conversely, the maximum of 256 variables can only be registered to profiles with a maximum capacity of 1,042,453. The maximum refers to 4 GB – for Linux with, for example, 1 GB of user address space, the information must be divided by four and, depending on the design of the memory, divided once again.

### 14.7 Appendix: C interface

The following section contains examples for the use of the DataRecApi programming interface for C applications.

All examples use the following configuration:

```c
[Xcrt]
  traceWord = -1
[Xcrt.Resource:0]
  name = "resource7"
[Xcrt.Resource:0.Task:0]
  name = "Task_1s"
  interval = 1000000
  priority = 5
[Xcrt.Module:0]
  codeFile = "libTestDataRecApp"
  moduleInitFunc="moduleInit"
  moduleStartFunc="moduleStart"
  moduleStopFunc="moduleStop"
  moduleExitFunc="moduleExit"
[Xcrt.Module:0.TaskConnection:0]
  context = "resource7.Task_1s"
  prio = 1
  hookClientFunc = "moduleCallback"
```

In addition, all examples share the same header:

```c
#include <stdint.h>
#include <stdio.h>
#include <string.h>
#include <unistd.h>
#include "TestDataRecApp.h"
#include "MemApi.h"
#include "LogApi.h"
#include "DataRecApi.h"
```
**General instructions**

Automatic recordings are to be configured in C-applications with the `DataRecApiSetRecContext` function. The function defines a task context for the recording based on the following information:

- Temporal distance of the individual recordings in μs
- Task priority of the individual recordings (from 1 = high to 31 = low)
- CPU task binding (starting from 0, or -1, for system-side selected standard binding)

With these settings a task is generated on the system-side, which is queued under the usual application tasks in regards to intermittency and priority. To fulfill certain requirements on the determinism of the recording, the interaction of this task with the remaining application tasks is to be taken into account. For example, if the time stamps of the data detect unwanted “jitter,” the selection of the above parameters is to be reconsidered. Furthermore, the priority should not be too high, the distance should not be too short and the quantity of data should not be too large in order to prevent a blocking of real-time-critical tasks.
**Information**

If manual recording is selected for a profile, note that calls from `DataRecApiSampleValues` are not only necessary for data recording, but also for state transformations in the profile. For automatic recording, the calls and the state transformations associated with them are made by the configured task. This must be implemented in the application for recording manually.

For example, a call from `DataRecApiSampleValues` involves the following additional steps, which can cause a state change from waiting to recording:

- Testing of a configured start-trigger condition for their occurrence
- Testing for the expiration of a start delay set with `DataRecApiSetRecCount`

Furthermore, in the case of the SingleShot buffer type, `DataRecApiSampleValues` causes a state change from recording to stopped when the end of the buffer is reached.

The recording mode (standard or change-based) of a profile can be configured using the `DataRecApiSetRecMode` function. In the change-based mode, the tolerance value can then be changed using `DataRecApiSetVarTolerance` or enabled using `DataRecApiRemoveVarTolerance`.

**Information**

In the change-based modes, note that a profile only detects changes of variable values in the course of the call from `DataRecApiSampleValues`. Writing the application to the monitored variable alone does not cause any recordings!

Using the `DataRecApiSetRecCount` function, the following limitations can be set:

- **Start delay**: Number of calls by `DataRecApiSampleValues` after the start of recording, which do not generate any recordings, but instead implement a countdown for the recording.
- **Number of the recordings to be stored**: Number of calls by `DataRecApiSampleValues` (without start delay) until the automatic recording stop.

Special case in the change-based recording mode with a monitored variable: The mere number of calls from `DataRecApiSampleValues` is not a part of the number of recordings to be stored, since not every call needs to be stored. Instead, only the actual recording calls of the function are those which count. In the remaining modes, by contrast, the pure calls to `DataRecApiSampleValues` do count.

You can set a trigger using `DataRecApiSetTrigger` and rescind it again using `DataRecApiRemoveTrigger`. 
Special case in the change-based recording mode with a monitored variable: The mere number of calls from by \texttt{DataRecApiSampleValues} is not a part of the number of recordings to be stored, since not every call needs to be stored. Instead, only the actual recording calls of the function are those which count. In the remaining modes, by contrast, the pure calls to \texttt{DataRecApiSampleValues} do count.

In the course of the registration, the \texttt{DataRecApiAddVar} registration function determines the locality of a variable. This information is made available to the user by means of the \texttt{DataRecApiGetFirstVar}, \texttt{DataRecApiGetNextVar} and \texttt{DataRecApiGetVars} query functions and can be used for inspection purposes. The delivered \texttt{isLocal} flag indicates whether the variable is process-local, and as such, that it can be sampled real-time capable.

Settings carried out using \texttt{DataRecApiSetSampleHook} are not permanent (code addresses depend on start-up), but rather must be newly carried out in the course of every start-up of the application (before the recording start).

14.7.1 Profile with manual recording

The following example shows the easiest application: The application registers two variables with a variable server via \texttt{MemApi} and registers their paths at a profile with the Continuous buffer type and a capacity of 1000 samples.

The recording is started in the start function, while it is stopped again in the stop function. The \texttt{ModuleCallback} application function is called up in one-second intervals and logs the variables by means of a call by \texttt{DataRecApiSampleValues}.

It is not necessary to explicitly delete the profile in the exit function, since all remaining profiles are deleted after all applications are exited. Persistent data is not affected by this deletion.

```c
void ModuleInit() {
    DataRecApiInfo info;
    DataRecApiResult rc;
    char varPath[80];
    LogApiAddId(traceid, "TestRec");
    LogApiTrace(traceid, "TestDataRecApp initialized");
    MemApiInit();
    MemApiAddVar(scVarNameTemp, MemApiInt32, &sTemp, sizeof sTemp);
    MemApiAddVar(scVarNamePres, MemApiReal, &sPres, sizeof sPres);
    sTemp = 0;
    sPres = 0.0;
    strcpy(info.name, scProfileName);
    info.size = 1000; /* space for 1000 samples */
    info.maxVarCnt = 5; /* max. 5 variables per sample */
    info.bufType = DataRecApiBufTypeContinuous; /* ring buffer type */
    info.level = DataRecApiLevelApplRt; /* (unsupported yet) */
    info.autoStart = 0; /* application starts recording */
    rc = DataRecApiCreateProfile(&info, &sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk && sP1Id != DataRecApiNoId);
    snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNameTemp);
    rc = DataRecApiAddVar(sP1Id, varPath, 0, &sTempId);
    ReturnIfNot(rc == DataRecApiResultOk && sTempId != DataRecApiNoId);
    snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNamePres);
    rc = DataRecApiAddVar(sP1Id, varPath, 0, &sPresId);
    ReturnIfNot(rc == DataRecApiResultOk && sPresId != DataRecApiNoId);
}
```

Data recorder

void ModuleExit() { 
    MemApiRemoveVar(scVarNamePres);
    MemApiRemoveVar(scVarNameTemp);
    MemApiExit();
    LogApiTrace(traceid, "TestDataRecApp unloaded");
    LogApiRemoveId(traceid);
}
/
****************************************************************************/
void ModuleStart() { 
    DataRecApiResult rc;
    LogApiTrace(traceid, "Starting TestDataRecApp");
    rc = DataRecApiStartRecording(sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk);
}
/
****************************************************************************/
void ModuleStop() { 
    DataRecApiResult rc;
    LogApiTrace(traceid, "Stopping TestDataRecApp");
    rc = DataRecApiStopRecording(sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk);
}
/
****************************************************************************/
void ModuleCallback(UserFuncParam *arg, uint32_t provArg) { 
    DataRecApiResult rc;
    rc = DataRecApiSampleValues(sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk);
    sTemp += 1;
    sPres += 0.1;
}

14.7.2 Profile with automatic recording

The following example builds upon the aforementioned by adding two points:
For one thing, recording takes place automatically. For that to happen, a
sampling in 10ms intervals is set with DataRecApiSetRecContext, while fur-
thermore a start delay of 2 seconds and a recording time of 5 seconds is set
with DataRecApiSetRecCount. For another, a callback from the recording
into the application is configured for the purpose of minimum-maximum de-
termination.

void ModuleInit() { 
    DataRecApiInfo info;
    DataRecApiResult rc;
    char varPath[80];
    DataRecApiContext ctx;
    DataRecApiCount cnt;
    /* for committed lines see example "manual recording" */
    snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNamePres);
    rc = DataRecApiAddVar(sP1Id, varPath, 0, &sPresId);
    ReturnIfNot(rc == DataRecApiResultOk && sPresId != DataRecApiNoId);
    ctx.intervalUs = 10000;
    ctx.priority = 16;
    ctx.affinity = -1;
    rc = DataRecApiSetRecContext(sP1Id, &ctx);
    ReturnIfNot(rc == DataRecApiResultOk);
    cnt.startDelayCnt = 200;
    cnt.durationCnt = 500;
    rc = DataRecApiSetRecCount(sP1Id, &cnt);
Data recorder

```c
ReturnIfNot(rc == DataRecApiResultOk);
rc = DataRecApiSetSampleHook(sPlId, UpdateMinMaxTemp, 0);
ReturnIfNot(rc == DataRecApiResultOk);
}

Callback function:
static int32_t sMinTemp = INT32_MAX, sMaxTemp = INT32_MIN;
/
*****************************************************************************/
static void UpdateMinMaxTemp(
    uint64_t timeStampUs, /**< [in] time stamp (μs since the epoch) */
    DataRecApiPos pos, /**< [in] sample position */
    DataRecApiVarSample *pSamples, /**< [in] variable samples */
    int32_t sampleCnt, /**< [in] length of \em pSamples */
    void *arg /**< [in] user argument */
) {
    int i;
    for (i = 0; i < sampleCnt; ++i) {
        if (pSamples[i].var == sTempId) {
            int32_t curTemp = pSamples[i].value.valSINT32;
            if (curTemp < sMinTemp) {
                sMinTemp = curTemp;
            }
            if (curTemp > sMaxTemp) {
                sMaxTemp = curTemp;
            }
        }
    }
    return;
}
} /*
*****************************************************************************/

14.7.3 Profile with triggered recording

The following example uses manual recording, whereby the span of recording time is limited by a start trigger and a stop trigger. Both of the two trigger conditions refer to the active Boolean variable created by the application. The start of the recording should be actuated by a transition from FALSE to TRUE, while the stop should be actuated by a transition from TRUE to FALSE. These conditions can be specified using the undershoot and overshoot operators. To do so, the active variable must initially have the value FALSE.

To be able to specify the path of the variables in the variable tree, they must be registered, like the recorded variables, by means of MemApi. However, unlike the monitored variables of a change-based recording, it does not need to be registered in the profile.

If a person sets the active variable to TRUE, and then a few seconds later back to FALSE again (in the example, not a component part of the application code), within the time span, the variables temperature and pressure are recorded. After the recording has been stopped, the number of the samples results from the difference of the trigger positions + 1, since the stop position indicates the position of the last sample.
/
*****************************************************************************/
* constants */
enum { cFALSE = 0, cTRUE = 1 };
static const char scProfileName[] = "TestDataRecAppP1";
static const char scVarNameTemp[] = "temperature";
static const char scVarNamePres[] = "pressure";
static const char scVarNameAct[] = "active";
/
*******************************************************************************
* static variables
*/
static int32_t sTemp;
static float sPres;
static int8_t sActive;
static DataRecApiProfileId sP1Id;
static DataRecApiVarId sTempId;
static DataRecApiVarId sPresId;
/
******************************************************************************/
void ModuleInit() {
  DataRecApiInfo info;
  DataRecApiTrigger trig;
  DataRecApiResult rc;
  char varPath[80];
  LogApiAddId(traceid, "TestRec");
  LogApiTrace(traceid, "TestDataRecApp initialized");
  MemApiInit();
  MemApiAddVar(scVarNameTemp, MemApiSInt32, &sTemp, sizeof sTemp);
  MemApiAddVar(scVarNamePres, MemApiReal, &sPres, sizeof sPres);
  MemApiAddVar(scVarNameAct, MemApiBool, &sActive, sizeof sActive);
  sTemp = 0;
  sPres = 0.0;
  sActive = cFALSE;
  strcpy(info.name, scProfileName);
  info.size = 1000; /* space for 1000 samples */
  info.maxVarCnt = 5; /* max. 5 variables per sample */
  info.bufType = DataRecApiBufTypeContinuous; /* ring buffer type */
  info.level = DataRecApiLevelApplRt; /* (unsupported yet) */
  info.autoStart = 0; /* application start recording */
  rc = DataRecApiCreateProfile(&info, &sP1Id);
  ReturnIfNot(rc == DataRecApiResultOk && sP1Id != DataRecApiNoId);
  snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNameTemp);
  rc = DataRecApiAddVar(sP1Id, varPath, 0, &sTempId);
  ReturnIfNot(rc == DataRecApiResultOk && sTempId != DataRecApiNoId);
  snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNamePres);
  rc = DataRecApiAddVar(sP1Id, varPath, 0, &sPresId);
  ReturnIfNot(rc == DataRecApiResultOk && sPresId != DataRecApiNoId);
  memset(&trig, 0, sizeof trig);
  snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNameAct);
  trig.startCond.op = DataRecApiTriggerOpPosSlope;
  trig.startCond.val.valBOOL = cFALSE;
  strncpy(trig.startCond.var, varPath, sizeof trig.startCond.var - 1);
  trig.stopCond.op = DataRecApiTriggerOpNegSlope;
  trig.stopCond.val.valBOOL = cTRUE;
  strncpy(trig.stopCond.var, varPath, sizeof trig.stopCond.var - 1);
  rc = DataRecApiSetTrigger(sP1Id, &trig);
  ReturnIfNot(rc == DataRecApiResultOk);
}
/
*******************************************************************************
void ModuleExit() {
  MemApiRemoveVar(scVarNameAct);
  MemApiRemoveVar(scVarNamePres);
Data recorder

MemApiRemoveVar(scVarNameTemp);
MemApiExit();
LogApiTrace(traceid, "TestDataRecApp unloaded");
LogApiRemoveId(traceid);
}
/
******************************************************************************
void ModuleStart() {
  DataRecApiResult rc;
  LogApiTrace(traceid, "Starting TestDataRecApp");
  rc = DataRecApiStartRecording(sP1Id);
  ReturnIfNot(rc == DataRecApiResultOk);
}
/
******************************************************************************
void ModuleStop() {
  DataRecApiResult rc;
  LogApiTrace(traceid, "Stopping TestDataRecApp");
  rc = DataRecApiStopRecording(sP1Id);
  ReturnIfNot(rc == DataRecApiResultOk);
}
/
******************************************************************************
void ModuleCallback(UserFuncParam *arg, uint32_t provArg) {
  DataRecApiSampleValues(sP1Id);
  sTemp += 1;
  sPres += 0.1;
}

14.7.4 Profile with persistence

The following example is more strongly distinguished from the previous examples. It uses a profile with persistence and, as such, must cover a number of cases: For one thing, the profile does not yet exist and must be newly created, and for another thing, the profile is already created on the system side due to the existing persistence, and thus must only be restarted.

The recovery of profiles takes place between the init- and start calls of the application, because the paths of the configured variables are also persisted and these are only valid after the initialization of all runtime systems. This requires a change of the application configuration: The determination or the initial creation of the profile thus takes place in the course of the start call. This step is integrated into the extra function InitRecording. The remaining steps are also highlighted in separate functions in order to better uncouple the recording from the rest of the application code.

Likewise, in the course of the initialization, an application task is created, which completely persists the profile every 10 seconds. The StartRecording function triggers the start of the task, while the StopRecording function enables the task to be terminated.

static void InitRecording() {
  DataRecApiInfo info;
  DataRecApiResult rc;
  char varPath[80];

  /*
   * create new profile or get restored profile
   */
  sP1Id = DataRecApiGetProfile(scProfileName, &info);
if (sP1Id == DataRecApiNoId) { /* create profile */
    strcpy(info.name, scProfileName);
    info.size = 1000;
    info.maxVarCnt = 5;
    info.bufType = DataRecApiBufTypeContinuous;
    info.level = DataRecApiLevelApplRt;
    info.autoStart = 0;
    rc = DataRecApiCreateProfile(&info, &sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk && sP1Id != DataRecApiNoId);
}

snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNameTemp);
rc = DataRecApiAddVar(sP1Id, varPath, 0, &sTempId);
ReturnIfNot(rc == DataRecApiResultOk && sTempId != DataRecApiNoId);

snprintf(varPath, sizeof varPath, "APPL.MEM.%s", scVarNamePres);
rc = DataRecApiAddVar(sP1Id, varPath, 0, &sPresId);
ReturnIfNot(rc == DataRecApiResultOk && sPresId != DataRecApiNoId);

{ DataRecApiContext ctx;
  ctx.intervalUs = 2000000;
  ctx.priority = 16;
  ctx.affinity = -1;
  rc = DataRecApiSetRecContext(sP1Id, &ctx);
  ReturnIfNot(rc == DataRecApiResultOk);
}

} else { /* profile restored */
    rc = DataRecApiStopRecording(sP1Id);
}

sRun = 1;
sStarted = 0;
sTerminated = 0;
sTaskHdl = CreateTask("LowPriorTask", LowPriorTask, 0, 24, 4096);
ReturnIfNot(sTaskHdl != 0);

} /* exit recording */

static void StartRecording() {
    DataRecApiResult rc;
    int ok;
    rc = DataRecApiStartRecording(sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk);
    ok = ResumeTask(sTaskHdl); ReturnIfNot(ok);
    sStarted = 1;
}

static void StopRecording() {
    DataRecApiResult rc;
    DataRecApiPos pos;
    sRun = 0; /* tell LowPriorTask to terminate */
    rc = DataRecApiStopRecording(sP1Id);
    ReturnIfNot(rc == DataRecApiResultOk);
}

static void ExitRecording() {
    if (sStarted) {
        while (!sTerminated) {
            LogApiTrace(traceid, "waiting for LowPriorTask to terminate...");
            sleep(1/*secs*/);
        }
    }
}

} /* exit recording */
Data recorder

```c
void ModuleInit() {
    /*
     * create variables to be recorded
     */
    MemApiInit();
    MemApiAddVar(scVarNameTemp, MemApiSInt32, &sTemp, sizeof sTemp);
    MemApiAddVar(scVarNamePres, MemApiReal, &sPres, sizeof sPres);
}
/
****************************************************************************/
void ModuleExit() {
    ExitRecording();
    MemApiRemoveVar(scVarNamePres);
    MemApiRemoveVar(scVarNameTemp);
    MemApiExit();
}
/
****************************************************************************/
void ModuleStart() {
    /*
     * now all variables are available such that profiles can be restored and
     * variables can be added to profiles
     */
    InitRecording();
    sTemp = 0;
    sPres = 0.0;
    StartRecording();
}
/
****************************************************************************/
void ModuleStop() {
    StopRecording();
}

Implementation of the persistence in 10 second intervals (with additional termination assessment per second):

/* libk2ctrl exports for advanced applications */
extern int CreateTask(const char *name, void (*fctAddr)(void *), void *param,
    int prior, int stackSize);
extern int ResumeTask(int hdl);
/
*****************************************************************************/
* static variables
*/
static int sTaskHdl;
static int sRun, sStarted, sTerminated;
/
****************************************************************************/}
void LowPriorTask(void *arg) {
    enum { cSaveStatePeriodSecs = 10 };    int cnt = cSaveStatePeriodSecs;
    DataRecApiResult rc;
    while (sRun) {
        sleep(1/*secs*/);
        if (--cnt == 0) {
            rc = DataRecApiSaveState(sP1Id);
            cnt = cSaveStatePeriodSecs;
        }
        }
    sTerminated = 1;
}
Upon the creation of free-running tasks by means of CreateTask, the application takes over co-responsibility for the stability of the system. After the recurrence of the exit function (end of the application), make sure that all created tasks have been terminated or these no longer execute calls of the offered APIs (among others, DataRecApi)!

14.7.5 Evaluation of recordings

The following code supplements the preceding examples by the evaluation of recordings that have been carried out. The parameters of the PrintSamples example function specify the buffer area to be read in the vertical (pos, cnt) and horizontal direction (maxVarCnt).

```c
static void PrintSamples(int maxVarCnt, DataRecApiPos pos, int cnt) {
    char *pBuf = malloc(DataRecApiUtilGetSampleMemSize(maxVarCnt, cnt));
    ReturnIfNot(pBuf != 0);
    DataRecApiSample *pSample = (DataRecApiSample *)pBuf;
    rc = DataRecApiReadSamples(sP1Id, maxVarCnt, &pos, pSample, &cnt);
    ReturnIfNot(rc == DataRecApiResultOk);
    for (i = 0; i < cnt; ++i) {
        actVarCnt = pSample->header.varSampleCnt;
        printf("[%d] recNo=%d, varSampleCnt=%d, timeStampUs=%s\n",
            i, pSample->header.sampleRecNo, actVarCnt,
            TimeStamp2DateStr(pSample->timeStampUs));
        for (k = 0, p = pSample->varSamples; k < actVarCnt; ++k, ++p) {
            switch (p->type) {
            case DataRecApiVarType_SINT32:
                printf(" name=%s, value=%d (size=%d)\n", VarIdToName(p->var), p->value.valSINT32, p->size);
                break;
            case DataRecApiVarType_REAL:
                printf(" name=%s, value=%f (size=%d)\n", VarIdToName(p->var), p->value.valREAL, p->size);
                break;
            default:
                printf(" name=%s, value=%" PRIx64 " (type=%d, size=%d)\n", VarIdToName(p->var), p->value.valNONE, p->type, p->size);
                break;
            }
        }
        pSample = (DataRecApiSample *)&pSample->varSamples[maxVarCnt];
    }
    free(pBuf);
}
```

Example call

PrintSamples(5, DataRecApiPosNewest, 1000);
Auxiliary functions for the formatting of time stamps and simple determination of variable names:

```c
static const char *TimeStamp2DateStr(uint64_t timeStamp) {
    static char sDateStr[80];
    struct tm *p;
    /* seconds and μs since 1970-01-01 */
    secs = (int)(timeStamp / 1000000);
    usecs = (int)(timeStamp % 1000000);
    p = localtime(&secs);
    if (p != 0) {
        snprintf(sDateStr, sizeof sDateStr, "%04u-%02u-%02u %02u:%02u:%02u.%03u",
                 p->tm_year+1900, p->tm_mon+1, p->tm_mday, p->tm_hour, p->tm_min, p->tm_sec, (unsigned)usecs);
    } else {
        snprintf(sDateStr, sizeof sDateStr, "xxxx-xx-xx xx:xx:xx.xxx");
    }
    return sDateStr;
}
```

```c
static const char *VarIdToName(DataRecApiVarId varId) {
    if (varId == sTempId) {
        return scVarNameTemp;
    } else if (varId == sPresId) {
        return scVarNamePres;
    }
    return "unknown";
}
```
15 Diagnostics

This chapter describes the diagnostic options of u-create. Depending on the delivery, not all diagnostics options may be available.

15.1 Control diagnosis

Errors during operation or operating states are indicated via the LEDs on the CPU module.

**PWR (Power)**

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark</td>
<td>No voltage supply</td>
</tr>
<tr>
<td>Green</td>
<td>Device running</td>
</tr>
</tbody>
</table>

**SF (System Fault)**

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark</td>
<td>No voltage supply or no error</td>
</tr>
<tr>
<td>Red</td>
<td>Severe system error (e.g. Fatal Error)</td>
</tr>
</tbody>
</table>

**RUN**

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark</td>
<td>No voltage supply</td>
</tr>
<tr>
<td>Green</td>
<td>Application is processed or setup finished</td>
</tr>
<tr>
<td>Flashing green</td>
<td>Application is stopped</td>
</tr>
<tr>
<td>Yellow</td>
<td>Ready for operation</td>
</tr>
<tr>
<td>Flashing yellow</td>
<td>Setup is executed</td>
</tr>
<tr>
<td>Flashing red</td>
<td>Setup failed</td>
</tr>
</tbody>
</table>

**Link/Activity LED**

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark</td>
<td>No connections</td>
</tr>
<tr>
<td>Flashing green/yellow</td>
<td>Data is transferred</td>
</tr>
<tr>
<td>Green</td>
<td>EtherCAT connection established (100 MBit/s, Full Duplex)</td>
</tr>
</tbody>
</table>

Via the Service App "DevAdmin" information of the control can be read and a state report as well as a crash report can be triggered. (see Device Administration (DevAdmin)).

15.1.1 Error codes

Depending on the version of the CPU module, different error messages can be displayed.
15.2 Diagnosis data for Weidmüller

If you encounter a problem with the u-create system and require support from Weidmüller, please collect the following information from your system and send it to Weidmüller.

15.2.1 Status report

In order to retrieve the status data of the control, please use the status report function. It can be triggered as follows:

- Via Service-App (DevAdmin)

**Triggering the status report via Service-App**

See "Device Administration (DevAdmin)".

15.2.2 Access to flash storage medium

The access to the flash storage medium can only happen via a SSH encrypted SFTP connection. Therefore a FTP program which is installed on the PC is needed. FTP programs are offered for download in the internet.

To establish a connection to the control with the FTP program the IP address of the control with the port number must be input into the FTP program.

In addition the following data which must also be inserted into the FTP program is needed for the connection establishment:

- Login data
- SSH key

For a detailed description see the help of the FTP program.

**Information**

*The selected FTP program must support an authentication via SSH encryption.*

**Login Data**

The following user exists on the control by default and can be used for the connection:

- service
- Admin

**Information**

*The login data cannot be changed.*

**SSH key**
For safety reasons it is necessary to change the SSH key pair (private key and public key).

**Changing the SSH key pair**

To generate a new SSH key pair a special program is needed. This program can be downloaded in the internet whereat the program "PuTTYgen" is recommended.

To change the SSH key with the use of "PuTTYgen" proceed as follows:

1) Start "PuTTYgen" on PC.

   ![PuTTYgen](image)

2) Select the type Types "RSA" (selected by default) in the lower area of the dialog.
3) Generate key via "Generate".
4) Save the private key via "Save private key" ([username]_key.ppk) to a directory on the PC.
5) Create a new text file named `authorized_keys` to a directory on the PC.
6) Mark and copy the whole text in the text field in the upper area of the download below "Public key for pasting into OpenSSH authorized_keys file:".
7) Copy the text into the file `authorized_keys`
8) Save and close the file.

The SSH key pair was generated.

The public key must be downloaded to the control. This is done differently for the existing users.

**User "service"**

To download the public key for the user "service" proceed as follows:

1) Start the FTP program and connect to the control.
2) Switch to the direction ssh-key and download the file `authorized_keys` from the PC to the control (existing file is overwritten).
3) Restart the control.

The SSH key has been changed. The new private key must be given when connecting now via SFTP connection to the control.

**User "Admin"**

To download the public key for the user "service" proceed as follows:

1) Right mouse click on icon "Software Service" in the taskbar of the PC.
2) Open path via "Open Software Service Path".
3) Copy the file `authorized_keys` in the corresponding directory:

<table>
<thead>
<tr>
<th>Taget directory</th>
<th>Target device</th>
</tr>
</thead>
<tbody>
<tr>
<td>\data\dsarmxilinx\kebwm\VersionNr\config\key\admin</td>
<td>UC20-SL2000-OLAC-EC</td>
</tr>
<tr>
<td>\data\dsx8genkeb\VersionNr\config\key\admin</td>
<td>KEBA control</td>
</tr>
</tbody>
</table>

The new public key is now stored and will be automatically download the next time "Create Target" (via u-create studio) is executed. Then the SSH key has been changed. The new private key must be given when connecting now via SFTP connection to the control.

**Directories on the flash storage medium**

The user is able to read and write in the following directories, but is not allowed to execute files:

<table>
<thead>
<tr>
<th>Verzeichnis</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>appldisk</td>
<td>Root directory for applications (Visualization application, IED, ...)</td>
</tr>
<tr>
<td>masterdisk</td>
<td>Root directory for base system</td>
</tr>
<tr>
<td>ssh-keys</td>
<td>Directory for the public key which can be changed</td>
</tr>
</tbody>
</table>
Diagnostics

<table>
<thead>
<tr>
<th>Verzeichnis</th>
<th>Beschreibung</th>
</tr>
</thead>
<tbody>
<tr>
<td>var</td>
<td>In this directory sub-directories for state report and crashreport are located</td>
</tr>
<tr>
<td>workspace</td>
<td>Root directory for files which are created during operation</td>
</tr>
</tbody>
</table>

15.3 **USB via Ethernet adapter**

In order to be able to use the "USB via Ethernet adapter", it is necessary to install your own driver. Otherwise, the adapter will be detected and used as a USB-only device. The necessary driver "USB Ethernet/RNDIS Gadget" can be downloaded from the Microsoft© Homepage (https://www.catalog.update.microsoft.com/).

For the Windows operating system to accept the driver, it must be installed manually. Proceed as follows to install the driver:

1) Rename the driver setup file *.cab in *.zip.
2) Unpack the *.zip file and save both files (*.inf and *.cat) on the PC.
3) Open the Device Manager.
4) Right-click on the serial USB device in subitem "Ports (COM & LPT)"

5) Click on "Update driver"
6) Click on "Browse my computer for driver software" in the following dialog.
7) Click on "Let me pick from a list of device drivers on my computer" in the following dialog.
8) Click on "Have Disk..." and select the *.inf file previously saved on the PC.
9) Select the driver.
10) Click on "Next".

Information
The USB interface is automatically assigned the IP address 192.168.227.1.

11) Close the dialog.
The Ethernet adapter now appears in the network settings and it is possible to connect the control via the IP address.
16 Maintenance

The following items fall under the maintenance of the system:

- Executing a system backup or restore
- Executing a firmware update
- Information about potential errors and their rectification

The backup of the system data includes the following information:

- Firmware that is saved on the storage medium
- Application programs and files including configuration files, message texts
- Operating data that was saved by the application programs
- Data on SRAM and EEPROM (e.g. retain data, user data)

**Information**

*It is recommended to generate a backup even on a new system as well as prior to any changes in the system (e.g. firmware update) and to store it securely in case a restore becomes necessary at a later point in time.*

The execution of the maintenance measures is described in the respective project engineering manuals.

16.1 Executing a firmware update of the system components

The u-create system permits the central, automatic update of the software running on the hardware modules.

There are the following variants of updates:

- Run update automatically when the control is started up

Before the firmware update can be implemented, a removable disk (e.g. SD card) with the relevant data must be created.

**Preparation**

The following is required for the preparation of the firmware update:

- An empty removable disk with min. 2 GB.
- Run-compatible system on the control (must not have the latest version status).
- The required storage medium must be plugged into the PC.
- Firmware update tool installed on the PC.

The firmware update tool provides the following options:

- Firmware update for control and bus coupler
16.1.1 Firmware-Update for devices

This chapter describes the creation of a storage medium to execute a
firmware update of the control.

To create a firmware update on a storage medium proceed as follows:

1) Start firmware update tool via double-clicking "u-create FirmwareUp-
date.exe".
2) Confirm the following dialogue with "Next".
3) Select the desired device from the list "devices".
   Press "show components" to show all software components, for which
   an update is available, in the list "components".
4) Select the desired update and transfer it to the list "selection" via >>.
5) Remove one or several updates from the list "selection" via << or "<<
   unselect all devices".
6) To create updates for several devices, repeat step 4 and 5.
   Confirm with "Next".
7) Select the root directory of the connected storage medium and confirm
   with "Next".
8) The following configuration dialogue opens:

   updateReference ... The update data will be additionally stored on the device.
Click on "Next".

9) The storage medium will be created via "Install".

**Information**
The storage medium must not be removed while it is being written to!

10) Exit the firmware update tool via "Finish".

**Information**
It is recommended to execute "Eject device" under Windows before removing the storage medium.

The storage medium for updating was created and can now be removed from the PC.

---

### 16.1.2 Automatic update during boot-up

Proceed as follows:

1) Connect the prepared removable disk to the control (with the CPU module switched off).
2) Connect the control to the power supply.
3) During the update, the control is in the INIT status.

**Information**
During the update, the power supply to the control must not be disconnected.

4) Remove the removable disk.
5) Restart the control.
17 Technical data

Detailed information concerning the technical data can be found in the respective project engineering manuals.
Directives and standards

Detailed information about directives and standards can be found in the project engineering manual of your modules.
19 Appendix: Tutorial - creating an IEC project

This tutorial describes step-by-step how a u-create studio project is created and programmed. Then, it illustrates how the project is uploaded onto a control and executed.

19.1 Creating a new project

Start u-create studio and call the command File > New project the main menu.

![Image of u-create studio - New project](image)

Fig. 19-15: u-create studio - New project

In the "New Project" dialog, select an empty project and enter a name and a location to save the project:
Fig. 19-16: Creating a new project

u-create studio automatically creates the project in the indicated directory and issues the addition "\.project".

The empty project opens and a target system can be inserted into the project tree. To do this, open the context menu of the project in the project tree and click on "Append Device...". This opens a dialog to select a control. The desired control is highlighted in this dialog and added to the project via "Append Device" or by double-clicking on it. After that, the dialog can be closed.

A program module can then be created in the project tree under the <Project name> > SPS logic > Application node. To do this, open the context menu for the node Application and select Add object > POU....
Appendix: Tutorial - creating an IEC project

![Image of software interface]

**Fig. 19-17: Add POU**

A dialog opens where you can set the name, the type, and the implementation language of the POU. In this example, the name "myProg", the type "Program", and the language ST (Structured Text) are used for the block:

![Create a new POU dialog]

**Fig. 19-18: POU settings**

After the settings have been selected, the POU is inserted under the node **Application** via "Add"; the program editor automatically opens and the work area is ready for additional programming.
19.2 Creating a simple program

The newly created POU is now expanded through programming: A numerical variable needs to be created that changes its value cyclically.

The necessary entries (declaration of a numerical variable, value change of the variable) can be carried out in the displayed editor via keyboard entries in the programming language ST (structured text) selected during the creation of the module. The upper editing area is intended for variable declarations and the editing area underneath (still empty) for program actions.

However, there are also tools in u-create studio that help to create the correct program commands. Dialogue supported variables can be created via the main menu command Edit > Auto Declare...:

Enter the name and data type of the variable. If you are not yet familiar with the data types available in u-create studio, click on the button ">" next to the entry field "Type" and via "Input assistance" open an input Wizard to select the desired data type there:
In this tutorial, a variable $X$ of the type DINT is to be declared:

\[
x := x + 1;
\]

The finished code in the u-create studio editor looks as follows:
After creating the program, a task must be created in which the program module needs to be processed. To do so, right click on Application in the project tree and select Add Object > Task Configuration.... A dialog opens, which can be used to create a node for several tasks in the project tree. Via Add the node is set up in the project tree under Application > Task Configuration, which already contains a task. It is automatically opened in the work area.

Fig. 19-24: Task configuration

The priority and interval of the task can be set in this window and the desired program module can be appended. The allocation of the POU takes place via Add + Call. A dialog opens in which the desired POU is selected and appended to the task.

Fig. 19-25: Appending POU to the task

The POU appended to the task is added to the project tree under the node Application > Task Configuration > Task.

A watchdog can be configured for the task. The task must be complete before the watchdog expires. The sensitivity of the watchdog can be adjusted.
19.3 Saving u-create studio project

The entire project is saved with the menu command **File > Save Project** or via the Save icon on the toolbar in the directory indicated during the creation of the project. The project is automatically compiled during the saving process.

19.4 Load firmware onto device

There is the possibility to install the firmware on a device (e.g. control) via a removable disk (e.g. SD card). Thereby, the whole control operating system, the runtime system and the application is stored on the removable disk and can be installed on any number of devices.

Therefore the following configuration settings have to be inserted in u-create in the menu **Tools ► Optionen...** under **Software Service**:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Server</td>
<td>localhost</td>
</tr>
<tr>
<td>System</td>
<td>System version which should be installed on the control or the active static operating panel</td>
</tr>
</tbody>
</table>

To create a removable disk disk it must be plugged into the PC. Then **Create Target** has to be selected in the context menu of the device in the project tree and the following dialog opens:

![Create Target dialog](image)

Fig. 19-26: Dialog - Create Target
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>Name of the control or the active static operating panel</td>
</tr>
<tr>
<td>Description:</td>
<td>Individual description</td>
</tr>
<tr>
<td>Destination:</td>
<td>Selection of the removable disk or any folder. If no removable disk is selected, a warning will be shown and the content is saved in the selected directory. If a removable disk is selected, it is checked whether the removable disk is a valid Service Medium. If it is no valid Service Medium, a warning is shown and the removable disk can be made valid or bootable via clicking on &quot;Prepare Service Medium (Administrator privileges required)&quot;.</td>
</tr>
<tr>
<td>Save relative path:</td>
<td>If this option is activated, the path will be stored relative to the project</td>
</tr>
<tr>
<td>PLC Name:</td>
<td>Name of the control or the active static operating panel</td>
</tr>
<tr>
<td>DHCP:</td>
<td>Use of a DHCP server</td>
</tr>
<tr>
<td>IP address:</td>
<td>IP address of the control or the active static operating panel</td>
</tr>
<tr>
<td>Subnet mask:</td>
<td>Subnet mask</td>
</tr>
<tr>
<td>Default gateway:</td>
<td>Gateway</td>
</tr>
</tbody>
</table>

**Optional packages** can be used to select additional software components (e.g. OPC-UA). By checking the box for the desired package and OK it will be saved on the removable disk and is available for installation.

A further dialog is opened via **Compatibility settings**, in which a range of serial numbers can be set using "Add". This means that the firmware on the removable disk can only be installed on the devices whose serial numbers lie within this range. This prevents accidental installation on the wrong device.

After all settings are made, the software can be stored on the removable disk via "Create" (dialog "Create target").

**Information**

*Never remove the removable disk during a storage procedure! This can lead to data loss.*

As soon as the display shows "Create target successfully completed ", the removable disk can be removed from the PC and the dialog window can be closed. The software package on the removable disk can now be installed on the desired device.
Installing firmware on devices without display

Caution
Never remove the removable disk during an update procedure nor disconnect the device from the power supply. This can lead to destruction of the firmware on the components and thus make a further operation impossible.

1) Set device currentless
2) Open front cover
3) Insert SD card

To install the prepared firmware on the removable disk on a device without display, proceed as follows:

1) Set device currentless.
2) Connecting the prepared removable disk to the device
3) Perform a restart of the device
4) The update process is carried out and displayed through a flashing orange LED
5) The update process is completely finished as soon as the Run/Stop LED lights green
6) Set device currentless and remove the removable device from the device
7) Perform a restart of the control

The firmware has been installed.
19.5 Configuration of the control

During the next step, the target PLC must be specified and configured. To do so, open the control configuration in u-create studio by double-clicking on the control in the project tree and switch to the "Communication Settings" tab:

![Communication settings](image)

By clicking on Scan in the top area of the window, all controls available in the network are displayed.

Select the control intended for your project and click on the button "Set Active". This sets the status of the control in the project tree to "RUN" and the control is highlighted in green.

The download of the translated project described below is applied to this control.

19.6 Compiling project and uploading onto control

The login dialog is opened using the menu command Online > Selective Download or by clicking the icon in the toolbar.

Enter the username and password in this dialog (default value: Administrator/tobechanged):

![Login dialog](image)

After the login the Selective Download dialog opens.
It can be selected which parts of the project are to be downloaded to the de-
vice.

![Selective Download to Device](image)

If a new configuration is loaded onto the control, the control must be
restarted. To do this, a dialog is displayed after the configuration is down-
loaded. If this dialog is confirmed, only the configuration is loaded onto the
control and the control implements a restart. The download of the other soft-
ware components can then be carried out. If the dialog is not confirmed, all
required software components are loaded onto the control. The control must
then be restarted.

19.7 **Starting the project**

The downloaded project has not been started yet. To do so, open the mod-
ule myProg in u-create studio by double-clicking on it and call up the menu
command **Debug > Start** (or function key **F5** or ▶ on the toolbar).

The sample program that was just created runs, and the value changes of
the variable utilized in the program module are indicated:
Appendix: Tutorial - creating an IEC project

Fig. 19-30: Started sample project
Appendix: Addressing in the Ethernet (basics)

Due to the separation of logic and physical protocol levels (Ethernet and TCP/IP) two types of addresses exist in the network:

- A fixed Ethernet address (MAC-ID) for each unit and
- an IP address, which is allocated to each unit in the network.

The application always sends data to or receives data from an IP address. To ensure their arrival at the receiver a connection must be established between the logic IP address and the physical Ethernet address. The Address Resolution Protocol ARP serves this purpose. An ARP table is stored in each network PC, which specifies the corresponding physical Ethernet address for the IP addresses of the network. If the ARP table does not list an Ethernet address, the IP driver can generally determine it via an ARP request.

**Ethernet address (MAC-ID)**

MAC-ID (Media Access Control) is the fixed address that clearly identifies an Ethernet device.

**IP address**

An IP address according to the standard IPv4 is generally specified with 4 decimal numbers divided by points (each 1 byte). Example for an IP address: 192.168.181.1

Both a network and an individual participant are allocated an IP address in the network. The IP address contains:

- The Net ID (specifies a network address) and
- the Host ID (specifies the address of an individual participant in the network). It must be unique, i.e. no two terminal devices can be operated with the same Host ID in the network.

A so-called net mask (subnet mask) is used to determine which numbers of an IP address represent the Net ID and the Host ID.

**Net classes**

With a "0" as wildcard the net mask for IP addresses defines which bits are used for addressing the participant (Host ID). A "1" as wildcard defines which bits the network address (Net ID) contains. The number of these bits determines which classes the networks belong to:

<table>
<thead>
<tr>
<th>Net class</th>
<th>Net mask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>255.0.0.0</td>
<td>Large network</td>
</tr>
<tr>
<td>B</td>
<td>255.255.0.0</td>
<td>Medium-sized network</td>
</tr>
<tr>
<td>C</td>
<td>255.255.255.0</td>
<td>Small network with a maximum of 254 participants</td>
</tr>
</tbody>
</table>
Example: In a small network with the net mask 255.255.255.0, at the IP address 192.168.181.1 the Net ID is 192.168.181 and the Host ID is 1. If (in a different, medium-sized network) net mask 255.255.0.0 is set, then at IP address 192.169.100.1, the Net ID is 192.169 and the Host ID is 100.1.

Gateway

Networks with different Net IDs are connected together via routers or gateways. If a network participant is to send data to a participant in a different network, the IP address of the gateway must be additionally specified. For addressing the IP three details must be specified:

- IP address
- IP net mask
- IP address of the gateway

Information on the addresses of your in-house network is available from the network administrator.

Setting the IP address

The settings for IP addressing can be manually configured for each terminal unit. In large networks this is done centrally and automatically by means of DHCP (Dynamic Host Configuration Protocol). Here a DHCP server administers the IP addresses and allocates them to the DHCP-capable terminal units. The Weidmüller controls are DHCP-capable. For this, the Enable DHCP command must be active in the Control configuration in u-create studio. The IP address is then allocated by the DHCP server in the network. During the boot-up the control then requests its IP address from the DHCP server via the network.
Access via FoE to a device (e.g. to load files onto the device) must be solved programmatically via the application. In this chapter, a firmware update on a UC20 bus coupler is executed as an example via FoE. The sequence of the firmware update is displayed in the message monitor.

**Programming block**

```plaintext
PROGRAM PRGECatFileTransfer

//Declaration of variables
VAR
  //Filetransfer
  state: IoApi_State;
  pass: UDINT;
  slavedir: STRING:= '';
  masterdir: STRING:= '/home/admin/FB-EC-FULL-0007674-01_08_00-9.bsc';
  dir: IoEcat_FileDirection:= IoEcat_FileDirection.download;
  mDevHandle: IoApi_Hdl;

  //Request "Bootstrap Mode"
  ReqBootstrap: BOOL;
  //Leave "Bootstrap Mode"
  LeaveBootstrap: BOOL;

  //Get Ethercat State
  GetState: BOOL;
  SlaveState: IoEcat_State;

  //State machine
  miState: DINT; msState: STRING;
  mbLoadNewFW: BOOL;
  msFileName: STRING;
  msFileDir: STRING;
END_VAR

//Block code

(* Used library: K_IoApi K_SystemCallLibrary Standard
Description:
1. File has to be downloaded to directory "\masterdisk" on control
2. Filename has to be set as value of "msFileName"
3. DeviceHandle of buscoupler has to be set (Property DeviceHandle of Ethercat Device)
4. mbLoadNewFW has to be set to TRUE *)

msFileName:= 'FB-EC-FULL-0007674-01_08_00-9.bsc';
msFileDir:= '/masterdisk/';
mDevHandle:= UR20_FBC_EC.DeviceHandle;
CASE miState OF
  0:
    IF mbLoadNewFW THEN
      mbLoadNewFW:= FALSE;
      miState:= 10;
    END_IF
  10: //Enter Bootstrap
    state:= IoApi_EcatEnterBootstrap(devHdl:= mDevHandle);
    IoApi_EcatGetState(devHdl:= mDevHandle,pState:= SlaveState);
    IF state = IoApi State.IoApiStateOk AND SlaveState = IoEcat_State.Bootstrap THEN
      msState:= 'Bootstrap entered';
```
KSys_TraceUOS(ADR(msState));
miState:= 11;
END_IF
11: // Download file
dir:= IoEcat_FileDirection.download;
slavedir:= '';
mastdir:= CONCAT(msFileDir,msFileName);
state := K_IoApi.IoApi_EcatFileTransfer(devHdl:= mDevHandle,
direction:= dir,
slaveFileName:= slavedir,
masterFileName:= mastdir,
password:= pass,
errorCode:= err);
IF state = IoApi_State.IoEcatFoEResultSuccess AND err = 0 THEN
  miState:= 20;
  msState:= 'File downloaded successful';
  KSys_TraceUOS(ADR(msState));
ELSIF err <> 0 THEN
  msState:= 'Error downloading File';
  KSys_TraceUOS(ADR(msState));
  miState:= 0;
END_IF
20: // Leave Bootstrap
state:= IoApi_EcatLeaveBootstrap(devHdl:= mDevHandle);
IoApi_EcatGetState(devHdl:= mDevHandle,pState:= SlaveState);
IF SlaveState = IoEcat_State.Operational THEN
  msState:= 'Leaving Bootstrap succesful';
  KSys_TraceUOS(ADR(msState));
  miState:= 21;
END_IF
21: // Wait for error or device
IF UR20_FBC_EC.HasError THEN
  miState:= 22;
END_IF
22: // Device OK
IoApi_EcatGetState(devHdl:= mDevHandle,pState:= SlaveState);
IF SlaveState = IoEcat_State.Operational AND NOT UR20_FBC_EC.HasError THEN
  msState:= 'FW Update succesful';
  KSys_TraceUOS(ADR(msState));
  miState:= 0;
END_IF
ELSE
  msState:= 'Wrong State';
  KSys_TraceUOS(ADR(msState));
END_CASE
Appendix: Tutorial - call C function from IEC

22 The u-create system offers the possibility to call C functions in IEC created with u-create studio C++.

Therefore a template with a predefinded interface for data exchange exists in u-create studio C++. It is recommanded to create a function in IEC which takes care of the call of the C function and the correct data exchange. The data exchange itself takes place on a shared memory area. Because of this only addresses on the memory area are transfered. The data types from IEC and C are not compatible, so on transfer of the parameters it must be payed attention on the correct type convetion.

Information
There is no automatically type checking. The user himself is responsible for the correct mapping. E.g. if the size of the data types does not match, a wrong memory area is accessed.

The example in this chapter describes the creation of a C function in u-create studio C++ and the call in a IEC application created in u-create studio.

22.1 Preconditions and needed components

The following components are necessary:

- u-create studio C++
- u-create studio
- u-create studio project with an executable IEC application
- Fitting hardware

The creation of this example requires basic knowledge in dealing with u-create studio and u-create studio C++.

22.2 Task

In this example application a self made C function should be called via an IEC function in the IEC application. The IEC function provides 3 local variables with different data types (DWORD, STRING[106] and REAL) and a global variable of type DWORD. The values of the variables should be changed in the C function as follows:

- The global variable of type DWORD should be summated with the variable of type DWORD
- The variable of type REAL should be multiplicated with 3.
- The variable of type STRING[106] should be extended with characters.
- The return value of the C function should be twice as much as the variable of type DWORD.
Afterwards, the changed values of the variables should be accessible in the IEC application again.

Therefore the following steps are necessary:

- Creation of the IEC function
- Creation of the C function and download to controller
- Call of IEC function in IEC application and download

### 22.3 Creating the C function and download

After starting the u-create studio C++ a new project is created via File ▶ New ▶ C/C++ Target Application in the menu bar.

In the dialog the following parameters are set:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project name</td>
<td>myProject</td>
</tr>
<tr>
<td>Location</td>
<td>C:\myProjects</td>
</tr>
<tr>
<td>Target</td>
<td>• UC20-SL2000: Control PLC V&lt;VersionNo&gt; ARMHF Linux</td>
</tr>
<tr>
<td></td>
<td>• KEBA control: Control PLC V&lt;VersionNo&gt; X86 Linux</td>
</tr>
<tr>
<td>Project Type</td>
<td>CoDeSys IEC Functions in C</td>
</tr>
</tbody>
</table>

Via Finish the project is created and displayed in the project tree.

In this project a C function already exists and the predefined interface is already created.

Under myIEC_C_Call ▶ include in the project tree the file MyIEC_C_Call.h is opened with a double click. In this file the structures for the input and output variables are declared respectively and so the interface is adapted to the IEC interface.

In the structure struct func1_IN the input parameters of the IEC function are displayed. The number of parameters has to correlate and a correct type mapping has to be done. Therefore the existing code is replaced by the following code in this example:

```c
struct func1_IN {
    int32_t *in_dword;
    const char *in_string;
    float *in_real;
};
```

In the structure struct func1_OUT the output parameters of the IEC function are displayed. The number of parameters has to correlate and a correct type mapping has to be done. Therefore the existing code is replaced with the following code in this example:

```c
struct func1_OUT {
    float *out_dword;
    char *out_string;
};
```

In the structure struct func1_Instance the global variable of the IEC function is displayed. Therefore the existing code is replaced with the following code in this example:
In addition both files `stdio.h` and `string.h` must be included.

To create the C function the file `MyIEC_C_Call.c` under `myIEC_C_Call` ➤ `src` in the project tree must be opened in the working area. The program code in the function `int func1(...)` is removed and replaced with the following code parts.

In the first code line the variable `char msg [106]` is defined. This variable is used later to buffer a text.

In the next code line the values of the input parameters (addresses of the memory area) which are delivered when calling the C function are displayed in the Trace Monitor of u-create studio.

```c
printf("func1 (called from IEC) with params: in_dword:%i, in_string:%s, in_real:%f \n", *(in->in_dword), in->in_string, *(in->in_real));
```

In the next lines the calculation is executed.

First the variable `inst_global` is added to the variable `in_dword`:

```c
*(inst->inst_global) += *(in->in_dword);
```

Then the variable `in_real` is multiplied with 3 and the result is assigned to the variable `out_dword`:

```c
*(out->out_dword) = *(in->in_real) * 3;
```

In the next step a text consisting of the variable `in_string` and additional characters is written to the variable `msg`. Then the content of the variable `msg` is copied to the variable `out_string`.

```c
sprintf(msg,"C-Function answering to \"%s\" .", in->in_string); strcpy(out->out_string , msg);
```

In the end the variable `in_dword` is multiplied with 2 and the result is returned as return value of the function.

```c
return *(in->in_dword) * 2;
```

The C function has been created.

Now the project is build via `Project ➤ Build All` in the manu bar and the output (`libMyIEC_C_Call.so`) is loaded to the control in the directory `/appldisk/application/control/ccontrol/` via `Download`.

### 22.4 Calling the IEC function in the IEC application and download

In the IEC application the created IEC function can be used. Therefore a program (e.g. `PLC_PRG`) in u-create studio is extended with the following code:

**Local variables**

```c
VAR
```
rv1: DINT;

res1 : REAL;
res2 : STRING [106];
END_VAR

In the code area the IEC function MyCFunction is called as follows:

rv1 := MyCFunction( in_dword := 17, in_string := 'Hello c-Function',
in_real := 25.58, out_real => res1, out_string => res2);

The variables res1 and res2 contain the variables calculated in the C function which can be used later in the application.

Then the project can be loaded to the control (see online help u-create studio) and finally it can be executed.
Index

C
C functions ........................................... 124
Configuration
  Control ............................................. 117
Creating project ................................. 108

D
DevAdmin
  Backup ............................................. 49
  Categories ....................................... 73
  Changing password ............................ 51
  Crashreport ....................................... 47
  Date ................................................ 49
  Device Information ............................. 46
  Device State ..................................... 46
  Groups ............................................. 73
  Interface Ethernet0 ............................ 48
  Login data ........................................ 45
  Long-term Diagnostic Monitor ............... 49
  Network Hostname .............................. 48
  Problems ......................................... 73
  Restore ........................................... 49
  Statereport ....................................... 47
  Time ................................................. 49

E
EtherCAT ............................................. 19
Ethernet
  Adressing .......................................... 120

F
Fast control ........................................ 30
Firmware
  Installing ......................................... 27

I
Interfaces
  EtherCAT .......................................... 19
  Modbus TCP/IP ................................. 19
  IP address ....................................... 17

M
Modbus TCP/IP ..................................... 19

N
Network address .................................. 17

P
Programming languages ........................ 20

S
Service PC
  Options for connections ....................... 18
  Status report ................................... 98

T
Tools
  Scope ............................................... 22
  u-create studio ................................. 20
  u-create studio C++ ............................ 21